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CONVENTIONS 
This document uses a few formatting conventions to help clarify when it’s referring to places in this 
document; areas of a program; or on-screen elements. 

• Links to places in this document are indicated using live links, which you can follow to the 
referenced topic, like this: 

This is a link to this topic: Conventions.  

• Windows, dialogs, and regions or panes within them, are indicated in THIS FONT, like this:  

The PROTECTION dialog is a type of window, as is the Windows standard FILE OPEN dialog. 

• Interactive on-screen elements, such as buttons and menus, are indicated in this font, like 
this:  

Click the OK or Cancel buttons. 

• Example text, such text that you might enter or keys that you might press, are indicated in 
this font, like this:  

Press CTRL+C to copy. Enter +1 in the box. 

If a reference is also a link to a topic in the document, it will always appear as a link, regardless of 
the normal indicator style. 
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MAIN WINDOW 
This is GCA’s primary window. Everything you work on with your character will begin here. 

ELEMENTS OF THE WINDOW 
The MAIN WINDOW is made up of several main elements: the menu bar, toolbars, character tabs, the 
workspace, Info and Logging pages, and the points bar. The main window is shown here with each 
element except the workspace highlighted. 

 

The section in the middle and left that is not highlighted is the Workspace, which will show you 
different views of your character, each providing a different way of interacting with the character 
you may be working on. In this image, the Unified View is being shown. 

The things you’ll see in the Workspace will vary based on the view you’re using, but the elements of 
the MAIN WINDOW will always be available, regardless of what you’re doing in the WORKSPACE. 

You can turn off or move certain window elements, which may adjust where you see them or if you 
see them at all. For example, the Logging Pane is displayed along the bottom of the window by 
default, but I moved it to the right side to get more vertical space; you can do that from the View 
menu, using the Logging Pane Location option. You can hide either pane by clicking the X button and 
you can also show or hide them using their named options on the View menu. 
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MENU BAR 
The menu bar has options for most of the primary features you may 
want to use. 

FILE MENU 

NEW 
Create a new character using the default character library (unless you 
change that in Options). 

NEW, CHOOSING LIBRARY… 
Creates a new character using the library that you select from the 
Manage Your Library dialog, which will pop-up after you choose this 
option. 

OPEN 
Opens the standard Windows FILE OPEN dialog, allowing you to select 
one or more characters to open into GCA. You can open characters 
saved from GCA4 and GCA5, but characters from GCA4 will not be able 
to be saved back to GCA4 format. You can also open character base 
files, and party files. 

OPEN RECENT FILE 
Opens a sub-menu that contains your most recently used character 
files, for quick access. 

CLOSE 
Closes the currently active character. If GCA recognizes that the character has been changed, it will 
ask if you’d like to save it first. 

CLOSE ALL 
Closes all the currently loaded characters. If GCA recognizes that a character has been changed, it 
will ask if you’d like to save it first. 

SAVE 
Saves the currently active character to the file system. If you have not previously saved the 
character (such as a new character, or a character loaded from a GCA4 save file) then you’ll be given 
the SAVE AS dialog instead, so that you may select the save file and location. 

SAVE AS 
Opens the SAVE AS dialog so that you can save your character to the file system, possibly changing 
the file name or location if it has been saved before. 

SAVE AS TEMPLATE 
Allows you to save the current character as a racial template or meta-trait in a book file. It will first 
call up the Template Options dialog for you to specify some options, and then will let you select the 
book file to save into. 
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SAVE ALL 
Saves all the currently loaded characters. If any have not previous been saved, it will open the SAVE 
AS dialog for them. 

MANGE YOUR LIBRARY… 
Opens the Manage Your Library window, allowing you to create, modify, or delete the various 
character libraries that you have available for your characters. 

PRINT… 
Sends the active character to the printer using this its primary character sheet. (You will get the 
standard Windows PRINT dialog first, if applicable.) You can set the primary sheet in Options > 
Current Character Options. 

PRINT PREVIEW 
Opens the Print Preview window using this character’s preferred character sheet. You can set the 
preferred sheet in Options > Current Character Options. 

PRINT SETUP 
Currently disabled. 

PAGE SETUP 
Opens the Windows PAGE SETUP dialog so you can set paper size and margins. 

EXPORT 
Opens the Select Export Sheet dialog, where you can select which export sheet you want to use to 
export the active character. (Note, some sheets may be able to export all open characters at once to 
one file.) 

EXIT 
Closes all characters and then shuts down GCA. You should be prompted to save characters that 
GCA recognizes as having been changed but not yet saved. 
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CHARACTER MENU 

RECALCULATE ALL 
This allows you to trigger a full recalculation of your character. This will 
also rebuild relationships between traits and other traits that they may 
affect, and between bonuses and penalties and the traits that may relate 
to them. 

RESYNCHRONIZE 
This will open the Resynchronize dialog, allowing you to resynchronize 
your character with library data. 

GCA characters are built on the self-containment principle: that 
everything your character needs to function should be included with the 
character itself. This means that you can send your character to a friend 
or GM, and they don’t have to have the exact same data as you have, 
they’ll still see your character exactly as it was meant to be.  

Many times, you may make a change in the library used with the 
character, such as by adding new books to it, and that may change how 
things are meant to work. However, because of the self-containment 
principle, those changes don’t necessarily apply to anything already 
added to the character, especially things like attributes and groups, 
elements that are automatically created when your character is first 
initialized.  

Resynchronize is a way to make sure that the data stored within the character matches up with 
what the current library for the character is. Be sure that your Logging pane is visible, though, 
because GCA will print there anything that it isn’t able to resynchronize correctly, and you may 
need to manually remove and re-add those traits—unless they’re ones that don’t need to be 
adjusted, of course. 

SWITCH LIBRARY 
This will allow you to change the library that is associated with, and used by, your character. You 
may want to do this if you accidentally started with the wrong library, or just have one you’d rather 
be using. 

You will probably want to Resynchronize your character after switching libraries. 

NEEDS CHECK 
This allows you to check prerequisites (also known as needs) for the traits on your character.  

GCA is pretty good about automatically checking these as you go, but some types are very hard to 
check automatically. If you see the P flag on a trait, and you’re not sure that it should still be there, 
you can do this to double check, and if it doesn’t go away, GCA will tell you why. 

GROUPS 
This opens the Groups dialog, which allows you to see what Groups are defined for your character. 
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TAGS 
This opens the Character Tags dialog, which allows you to see what tags are defined at the 
character level, to edit or delete them, and to add new ones. 

MESSAGES 
This opens the Messages dialog, which allows you to see what messages have been generated for 
your character. Messages can be created by various traits, especially templates, to remind you 
about things you may have to do (such as spend points on spells). You can delete messages once 
you no longer need them. 

APPEARANCE 
This opens the Appearance dialog, which allows you to set appearance values and your race. 

CAMPAIGN LOG 
This opens the Campaign Log dialog, which is where you can record happenings in your character’s 
adventures, as well as earned experience and money. 

CAMPAIGN SETTINGS 
This opens the Campaign Settings dialog, where you can change your point allowances and limits (if 
any), tech level. and starting money. You can also see what might be affecting Wealth. 

DESCRIPTION 
This opens the Description & Notes dialog, which allows you to enter text describing your character 
or to enter notes related to your character. Using this option will open the dialog with the 
DESCRIPTION TAB already selected. 

LOADOUTS 
This opens the Loadout Manager dialog. The LOADOUT MANAGER is an essential part of GCA, as it’s 
where you can add the various things your character owns to the various loadouts they might have. 
Loadouts affect encumbrance and what you may have available for protection. 

NOTES 
This opens the Description & Notes dialog, which allows you to enter text describing your character 
or to enter notes related to your character. Using this option will open the dialog with the NOTES TAB 
already selected. 

PORTRAIT 
This opens the Portrait dialog, which allows you to set a character portrait image. 

PROTECTION 
This opens the Protection dialog, which allows you to set up your armor and active defenses, as well 
as specify body types and hit location tables. 

TRANSFORMS 
This opens the Transform Manager dialog. Transforms allow you to specify certain traits that only 
apply when in certain forms or variations. This allows for a convenient way to shift your character 
in some major ways very quickly. If you like characters with multiple forms, this is for you. 
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TRAITS MENU 
For most of the options on this menu, you must have one or more traits 
selected in the workspace for the option to function. 

EDIT 
Displays the Edit Traits dialog for the selected traits. 

MODIFIERS 
Displays the Modifiers dialog for the selected traits. 

COLLAPSE/EXPAND 
Inverts the current setting for whether the children are currently 
expanded for display below the selected parent traits. 

Note that for components (children owned by templates), you may still not 
see the expanded list if the Components toolbar item is not also checked. 

DELETE 
Deletes the selected traits. 

You can retrieve deleted traits from the Recycle Bin until this character is unloaded. 

COPY 

Displays a sub-menu that allows you to choose whether you want to copy the selected traits, or the 
modifiers of those traits, into the clipboard buffer. 

Traits or modifiers copied into the buffer are stored as an XML fragment in plain text, so you can 
paste it into Notepad or a forum post.  

PASTE 
Pastes data from the clipboard buffer into GCA. 

How exactly the paste works depends on the type of data stored in the buffer: 

• If the data is traits, then those traits are added to the character, inserting them into the 
correct list regardless of which list is currently selected. (If you aren’t currently in a trait 
list, it may not paste in.)  

• If the data is modifiers, then it will add those modifiers to the currently selected traits. 
• If the data is something else, such as plain text, then you’ll need to be in an active edit box of 

the correct type to paste it in. 

Copying and pasting a trait using the shortcut keys (CTRL+C then CTRL+V) will quickly allow you to 
duplicate a trait one or more times, or to copy and paste traits to a different character. 
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HIGHLIGHT 

 

Allows you to apply one of the available highlights to the currently selected traits. 

You can clear existing highlights by selecting the None option. 

GM SHEET 

 

Allows you to toggle the inclusion or exclusion of the selected traits in the GM Sheet list. 

BONUS GRANTING 

 

Allows you to toggle the active or inactive state of a trait, which will determine whether bonuses 
from that trait are applied or not. In addition, inactive traits are not considered to exist when 
checking for traits that might count as prerequisites. 

Inactive traits are marked with a red X icon on the right side of the trait list and appear dimmed in 
the list. 

PARENT/CHILD 

 

Allows you to add or remove children, create new potential parents, or remove potential parents. 

Add to Parent: Shows a dialog with eligible parent traits that you can add the selected traits to as 
children. 
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Remove from Parent: Removes the selected traits from their current parent and moves them into 
their main list. 

Mark as Parent: Marks the selected traits as parent items, so that they will appear as valid parents 
when Add to Parent is selected, or when dragging items in the list. 

Unmark as Parent: Removes the marker that indicates the selected traits are potential parents. This 
does not remove any children or in any way prevent the traits from acting as parents, it just makes 
it so you can’t add new children to them. 

COMPONENT 

 

Allows you to enable or disable a component. 

Components are owned children of templates or meta-traits. They may also be locked to prevent 
changes. (Early templates, such as those in the Basic Set, were almost always locked. Newer 
templates tend to be made with the components locked so you can change the components 
relatively freely.) 

Using Disable on a component is the official way to remove a template component, which effectively 
says “this doesn’t apply to my specific case for this template.” GCA will mark the item with a 
*Disabled* marker and will add a new template component of the same name that begins with NO 
and has an opposing cost. These changes disable the trait and adjust the cost of the template to 
compensate. 

If you later select either the disabled trait or the NO version, you can use the Enable option to re-
enable the trait, removing the disabled state and the opposing cost version, and restoring that 
element of the template. 

NEEDS 

 

This allows you to check prerequisites (also known as needs) for the selected traits, or for the whole 
list to which they belong (in the picture, traits in the Skills list are currently selected). 

GCA is pretty good about automatically checking these as you go, but some types are very hard to 
check automatically. If you see the P flag on a trait, and you’re not sure that it should still be there, 
you can do this to double check, and if it doesn’t go away, GCA will tell you why. 
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PARTY MENU 

SAVE PARTY LIST 
Saves all the open characters to a party file, so that you can open them all 
again from a single file reference. 

A party file has a .gca5party extension, and includes a reference to the save file for each of the 
character files included. If you later save characters to different save files, you’ll want to resave the 
party file. 

PARTY LOG ENTRY 
Opens the Party Log Entry dialog, which allows you to write a single campaign log entry which will 
get published to the campaign log of every currently loaded character. 
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VIEW MENU 

TOOLBARS 
Allows you to set which toolbars are displayed. 

INFO PANE 
Allows you to toggle on or off if the Info Pane is displayed. 

LOGGING PANE 
Allows you to toggle on or off if the Logging Pane is displayed. 

LOGGING PANE LOCATION 
Allows you to set whether the Logging Pane is displayed at the bottom of the window, or below the 
Info Pane on the right side. 

FLOATER 
Allows you to set whether the Floater window may be displayed or not. Note that the FLOATER is not 
always visible, even when set to be displayed. The FLOATER only displays for traits that have Uses 
values set. 

ZOOM 
Allows you to set the programs Zoom mode, and whether to display the extra-large toolbar buttons. 

USE TABLET MODE 
If this option is enabled, GCA will operate in a mode where all sizable dialogs pop up over the Main 
Window’s same location with the same dimensions; or, if it can’t resize, at least over the top of it. As 
suggested by the name, this is intended to simplify running on a tablet, but is also useful if you want 
to confine all GCA dialogs to the same area. 
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TOOLS MENU 

PLUGINS 
Opens the Plugin Manager dialog, where you 
can see what plugins (sheets, exporters, and 
Unified View boxes) are loaded, which are 
disabled, and where they are being loaded 
from. 

BUILD CAMPAIGN BOOK 
Opens the Build Campaign Book dialog, 
where you can start with a library, adjust 
settings, pare down what traits you don’t 
want to include, and then save the results out 
as a book file to represent your campaign. 
You can then share that book with your players to use when they make their characters. 

APPLY A RANDOMIZED TEMPLATE 
This allows you to apply a template to the active template, randomly making any choices required. 
(You may still have to go back and fill in specialties or other text inputs where you were expected to 
enter them, but most of those should be filled with FILL THIS IN during the process.) 

Note that you can do something very similar by adding a template to your character and then 
selecting Randomize remaining template selections from the drop-down list of the Random button 
available on a Select dialog. 

CREATE NEW CHARACTERS FROM A RANDOMIZED TEMPLATE 
This opens the Random Character dialog, where you can pick a library, and then make up to 20 
random characters from a template contained within. This may take a while, and you will see 
dialogs popping up, and text appearing in the INFO PANE, during the process. 

FIND TRAITS 
Opens the Find Traits dialog, which allows you to search for specific traits across the library or just 
within the character. 

RECYCLE BIN 
Opens the Recycle Bin, which allows you to restore traits that you have deleted from the character 
this session. Once a character is closed, any deleted traits are no longer available to be restored. 

CHARACTER SHEET OPTIONS 
Opens the Character Sheet Options dialog, which allows you to change options for all the currently 
available character and export sheets. 

OPTIONS 
Opens the Options dialog, which allows you to change options for GCA itself, set default options for 
new characters, and adjust options for currently loaded characters. 
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HELP MENU 

USER GUIDE (PDF) 
This will launch the USER REFERENCE GUIDE PDF (this document) in 
Windows using your default PDF application. 

CHECK FOR UPDATES 
Closes GCA and runs the GCA5 Package Manager, which allows you to check for updates and to 
install optional packages (such as new character sheets, exporters, or boxes for Unified View). 

CREDITS 
Opens the Credits dialog. 

ABOUT 
Opens the About dialog. 
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TOOLBARS 
Toolbars provide a selection of the main options you may need to use frequently. 

Toolbars have a grip on the left side which you can use to rearrange the order or position of the 
toolbars within the toolbar area at the top of the window. 

SYSTEM TOOLBAR 

 

This toolbar provides quick access to the primary file system operations, such as creating a new 
character or saving the current one, and options for GCA and the loaded characters. 

NEW 

 

Clicking the primary button on the left will create a new character using the default character 
library (unless you change that in Options). 

Clicking the menu sub-button on the right will drop-down a menu with two options. 

 

New, with Default Library: This option will create a new character using the default character 
library. 

New, Choosing Library: This option will create a new character using the library that you select from 
the Manage Your Library dialog, which will pop-up after you choose this option. 

In Options, you can change the default behavior of the primary button to instead work like the New, 
Choosing Library option. If you do that, you’ll still have the menu options to select from if you want 
to start a new character using whichever option you did not set. 

OPEN 

 

Clicking the primary button on the left will open the standard Windows FILE OPEN dialog, allowing 
you to select one or more characters to open into GCA. You can open characters saved from GCA4 
and GCA5, but characters from GCA4 will not be able to be saved back to GCA4 format. You can also 
open character base files, and party files. 

Clicking the menu sub-button on the right will drop-down a menu that contains your most recently 
used character files, for quick access. 
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SAVE 

 

Saves the currently active character to the file system. If you have not previously saved the 
character (such as a new character, or a character loaded from a GCA4 save file) then you’ll be given 
the SAVE AS dialog instead, so that you may select the save file and location. 

CLOSE 

 

Closes the currently active character. If GCA recognizes that the character has been changed, it will 
ask if you’d like to save it first. 

EXPORT 

 

Clicking the primary button on the left will automatically launch the export process for this 
character’s preferred Export sheet. You can set the preferred sheet in Options > Current Character 
Options. 

Clicking the menu sub-button on the right will drop-down a menu that contains the other possible 
export sheets that you have set for the character, allowing you to quickly export using one of those 
instead. You can set the sheets that appear here in Options > Current Character Options. 

PRINT 

 

Sends the active character to the printer using this its preferred character sheet. (You will get the 
standard Windows PRINT dialog first, if applicable.) You can set the preferred sheet in Options > 
Current Character Options. 

Clicking the menu sub-button on the right will drop-down a menu that contains the other possible 
character sheets that you have set for the character, allowing you to quickly print using one of those 
instead. You can set the sheets that appear here in Options > Current Character Options. 

PRINT PREVIEW 

 

Clicking the primary button on the left will automatically open Print Preview using this character’s 
preferred character sheet. You can set the preferred sheet in Options > Current Character Options. 

Clicking the menu sub-button on the right will drop-down a menu that contains the other possible 
character sheets that you have set for the character, allowing you to quickly preview using one of 
those instead. You can set the sheets that appear here in Options > Current Character Options. 

MANAGE YOUR LIBRARY 
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Clicking the primary button on the left will open the Manage Your Library dialog, allowing you to 
create, modify, or delete the various character libraries that you have available for your characters. 

Clicking the menu sub-button on the right will drop-down a menu with two options. 

  

Manage Your Library: This option is the same as clicking the primary button: it opens the Manage 
Your Library dialog. 

Reload This Library: This option reloads the library being used by the currently active character. 
This is helpful in some situations, such as when you save customized items to a custom user book 
included in the library, and you want to reload and refresh the various library lists to include that 
custom information.  

OPTIONS 

 

This opens the Options dialog, allowing you to set your preferences for how GCA works, as well as 
various options for characters, both by default and specifically for those currently loaded. 

CHARACTER SHEET OPTIONS 

 

This opens the Character Sheet Options dialog, which allows you to set your preferences for the 
various character and export sheets that may be available to you. 

SYSTEM COLORS 

 

This opens the System Colors dialog, which allows you to change many of the user interface colors 
in GCA. 
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CHARACTER TOOLBAR 

 

This toolbar provides quick access to the primary character dialogs that let you edit all the aspects 
of a character that are not traits, such as a character portrait, campaign logs, campaign settings, 
armor worn, and so forth. For editing traits such as advantages or skill, you’ll primarily be using the 
views and features available within the primary window itself.  

CAMPAIGN LOG 

 

This opens the Campaign Log dialog, which is where you can record happenings in your character’s 
adventures, as well as earned experience and money. 

CAMPAIGN SETTINGS 

 

This opens the Campaign Settings dialog, where you can change your point allowances and limits (if 
any), tech level. and starting money. You can also see what might be affecting Wealth. 

LOADOUT MANAGER 

 

This opens the Loadout Manager dialog. The LOADOUT MANAGER is an essential part of GCA, as it’s 
where you can add the various things your character owns to the various loadouts they might have. 
Loadouts affect encumbrance and what you may have available for protection. 

TRANSFORM MANAGER 

 

This opens the Transform Manager dialog. Transforms allow you to specify certain traits that only 
apply when in certain forms or variations. This allows for a convenient way to shift your character 
in some major ways very quickly. If you like characters with multiple forms, this is for you. 

PROTECTION 

 

This opens the Protection dialog, which allows you to set up your armor and active defenses, as well 
as specify body types and hit location tables. 
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APPEARANCE 

 

This opens the Appearance dialog, which allows you to set appearance values and your race. 

PORTRAIT 

 

This opens the Portrait dialog, which allows you to set a character portrait image. 

NOTES 

 

This opens the Description & Notes dialog, which allows you to enter text describing your character 
or to enter notes related to your character. 

FIND TRAITS 

 

This opens the Find Traits dialog, which allows you to search for traits within the active library or 
the active character. 

RECYCLE BIN 

 

This opens the Recycle Bin. This button only activates if there are currently deleted traits available 
to be restored. Once a character is closed, any deleted traits are no longer available to be restored. 

  



24 
 

VIEW TOOLBAR 

 

This toolbar provides access to settings that change how you see various trait lists, and the type of 
interface that you’re using to interact with them. 

SHOW HIDDEN TRAITS 

 

Some traits are normally hidden from your view. Checking this option will display hidden traits 
instead of hiding them. 

SHOW COMPONENT TRAITS 

 

Components are the traits that make up a meta-trait or a racial template. Often, these traits are not 
listed individually on the character, instead being wholly subsumed within the meta-trait or 
template. By checking this option, those component traits will be displayed as children under the 
owning trait. (Note that many such traits are also hidden; if you also have Show Hidden Traits 
checked, you may see component traits as hidden items in various lists.) 

SHOW DIRTY 

 

When you make a change to one trait, it may affect other traits as well. By turning on Show Dirty, 
you can see all the traits that appear to have changed in some way because of your change to the 
original trait. By default, all changed traits get an orange background, but you can change that in 
System Colors. The reach of this feature is limited, working best when you change levels or points, 
but it can still be useful at times. (This is not a checked button, but rather will stay highlighted when 
the option is On.) 

EASIER DRAGGING 

 

This probably shouldn’t be on the toolbar, but instead in Options somewhere. When Easier Dragging 
is checked, the allowed wiggle room to determine if you’ve started dragging something is a bit 
larger. 

SWITCH TO UNIFIED VIEW 

 

Switches to the Unified View. When you are in UNIFIED VIEW, it is checked. 

SWITCH TO CLASSIC VIEW 
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Switches to the Classic View. When you are in CLASSIC VIEW, it is checked. 

SWITCH TO SHEET VIEW 

 

Switches to Sheet View. When you are in SHEET VIEW, it is checked. 

SWITCH TO PARTY VIEW 

 

Switches to Party View. When you are in PARTY VIEW, it is checked. 
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CHARACTER TABS 
When you have no characters loaded yet, the tabs will look like this: 

 

When you have some characters loaded, each will be listed as a tabs. You can click the tabs to switch 
between characters. 

 

If you have too many characters to display, the ones you can’t currently see will be available in a 
drop-down list from the drop-down button at the right end of the tabs bar. 

INFO PANE 
The INFO PANE will display information to you about the currently 
selected traits. You’ll see different types of information depending 
on whether you’ve clicked on a book trait or a character trait. 

Most of the information included is simple reference information or 
quick details on this you should know (such as related taboo traits). 
For full details, you may want to reference the PDF where the trait 
comes from. For that, you may be able to click the blue (by default) 
page references to launch the related PDF in your PDF reader. 

You can customize what reader gets launched (that may require 
some research on your part) and how the links look, in the OPTIONS 
dialog. You can also specify where the PDFs may be found and what 
the names of the PDFs are, as well. 

LOGGING PANE 

 

The LOGGING PANE contains information about what GCA is doing, and what problems or issues it 
may come across while it’s working. Many people prefer to turn this pane off because this 
information often isn’t particularly useful. However, if you’re having some types of problems, you 
may want to make sure this pane is on, to see if something useful is being displayed there. 
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POINTS BAR/STATUS BAR 

 

The POINTS BAR along the bottom of the Main Window displays point and money information about 
the active character. (Shown here split into two parts to fit the page and remain readable.) 

Values in red mean that they’re exceeding limits set in Campaign Settings. 

The Disadvantages box shows the total for traits in the disadvantages list, and in parentheses next 
to that is the total value counted against any Disadvantage Limit set in Campaign Settings. 

This is also the STATUS BAR, and it may occasionally change to show other information, such as when 
loading files or when using the type-to-search feature. Sometimes it will hide the POINTS BAR 
information when doing this, and other types it will just add additional temporary information. 
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WORKSPACE (MAIN WINDOW) 
The WORKSPACE within the Main Window has several different views that change how you see and 
interact with traits and other character information. 

UNIFIED VIEW 
UNIFIED VIEW allows you to interact with traits and other types of character information in a single 
view using different boxes of information. By default, these boxes are for all trait types, plus 
Protection, Portrait, General Information, Move & Encumbrance, and more.  

 

UNIFIED VIEW TOOLBAR 
 

This toolbar allows access to commonly needed features within the UNIFIED VIEW that may be 
shared by multiple traits or that apply specifically to how the view works. 

Here are the buttons on the toolbar from left to right: 

LIBRARY PANE 

 

Allows you to open or close the Library Pane along the left side of the View. 
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LAYOUT MENU 

 

This button is a drop-down menu. The icon changes to reflect the currently selected layout pattern 
for the BOXES PANEL, which are the first four options on the list. 

The Layout Options… option will open the Unified View Layout dialog. 

VERTICAL PAGE OVERRIDE 

 

Allows you to override the normal layout settings, and instead force all boxes into a vertical non-
wrapping layout. It will also size all the boxes to the width of the current display area. 

HORIZONTAL PAGE OVERRIDE 

 

Allows you to override the normal layout settings, and instead force the boxes into a horizontal 
non-wrapping layout. 

EDIT 

 

This will open the Edit Traits dialog with all currently selected traits. 

DECREASE LEVEL 

 

Decreases the levels (if possible) for all currently selected traits. 

INCREASE LEVEL 

 

Increases the levels (if possible) for all currently selected traits. 

DELETE 

 

Deletes all currently selected traits. 
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MODIFIERS 

 

This will open the Modifiers dialog for all currently selected traits. 

LIBRARY PANE 
Along the left side of this View is the Library pane. This is where you can select all the various types 
of traits to add to your character from the character’s library. 

BOXES PANEL 
The boxes of the Unified View sit on the BOXES PANEL. You can use the mouse on the empty space of 
this panel to click and drag the panel around, changing which boxes you’re looking at without using 
the scrollbars. 

BOXES 
UNIFIED VIEW allows for expansion through plugins, so it may have even more boxes available in the 
future. Following are the boxes currently included with GCA, listed here by the names of the control 
plugins that create them (for reference in the Plugin Manager). 

ATTACK MODES BOX 

 

This box has one instance each for Melee and Ranged attacks. The box will change its display to 
match the type of attack it contains. In the example image, the melee attacks are shown for our 
sample character. 

You may double click any attack in the list to launch Edit Traits for the trait that generates the 
attack. If you select multiple items, you can launch Edit Traits for all of them using the Edit button 
on the UNIFIED VIEW TOOLBAR. 

Gear Menu 
This menu provides options for the box. 
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Double Width: This tells GCA that you’d like to display this box at double the normal column width. 

Options…: This opens an Options dialog for this box, allowing you to change some options that 
change how the box displays its contents. 

ENCUMBRANCE & MOVE BOX 

 

This box displays encumbrance, move, and dodge information for your character, with their 
selected loadout. 

Each movement type available to your character is shown, and if they have an enhanced movement 
mode, that will be shown after their normal move, separated by a slash (/). I have added Enhanced 
Move (Ground) to the sample character, so that you can see on the Ground Move line what an 
enhanced move looks like. 

The current encumbrance level will be indicated with a box. You can see None is indicated in the 
example. 

The Loadout drop-down will allow you to change the character’s active loadout. 

GENERAL INFORMATION BOX 

 

This box displays the general information and a few basic attributes for the character. You can edit 
all the fields above the Character In Play checkbox, but the information at the bottom is only for 
reference. 
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MESSAGE CATCHER BOX 

 

This box displays any messages that have been triggered by traits being added to your character. 
Once you have dealt with the message, you can click the Dismiss this message box to discard it. 

Note that messages are not preserved across sessions in GCA, so once this character closes, any 
remaining messages are lost. 

PORTRAIT BOX 

 

This box displays the character’s portrait image (I’ve clipped the example image here). 

If you click the Portrait button in the upper right corner, it will launch the Portrait dialog so that you 
can load or change the portrait image. 
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PROTECTION BOX 

 

This box displays your character’s current protection values, based on the armor, shields, and 
protective traits that you’ve applied in the Protection dialog. 

For each location you have selected to show (the defaults are shown here), you’ll see the current 
DR. If layering is an issue, you’ll see indicators of that as well as the number of layers at that 
location. 

The inset image shows the DB for each shield arc based on active shields. 

Clicking the shield button in the upper-right corner will open the Protection dialog. 

The Loadout drop-down at the top allows you to change the character’s active loadout, which will 
likely change the protection available. 

The list under the protection image shows each item providing protection. Selecting an item will 
highlight each location being covered by that item. Double-clicking or clicking the Unified View 
Toolbar Edit button will open Edit Traits for that item. 

Gear Menu 
This menu provides options for the box. 
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Double Width: This tells GCA that you’d like to display this box at double the normal column width. 

Do Not Show Locations of DR 0: This will hide protection boxes with only DR 0, to help unclutter the 
image and only show locations that actually have some protection. 

Copy to Clipboard: This copies the contents of this box to the clipboard as a bitmap image. 

 

REACTION BONUSES BOX 

 

This box displays the various reaction modifiers and their totals. This is for reference; nothing in 
this box is interactive. 

TRAIT LIST BOX 

 

This box has one instance per type of trait, from Attributes and Advantages through Templates and 
Equipment. The box will change its display to match the type of trait it contains. In the example 
image, the Advantages and Equipment boxes are shown for our sample character. 

When you click a single trait, buttons may appear on the trait to allow you to make certain changes. 
For example, if you can adjust the count, level, or score of the item, you should get the + and – 
buttons to increment or decrement it. You should also see the Edit button on the right side, which 
will call up the Edit Traits dialog. 
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If you select multiple items, you’ll have to use the buttons in the Unified View Toolbar to manipulate 
them or make selections from the right-click menu. 

Within the list for each box, you may use type-to-search as well. 

If you right-click a selected trait, you will get the right-click menu, which duplicates the Traits 
Menu. 

Capacity Meters 
The character’s trait boxes support displaying capacity meters.  

Gear Menu 
This menu provides options for the box. It’s standard across the Trait List Box type, but different 
boxes may adjust the options if necessary. 

 

Refresh Box: This forces the box to redraw itself. 

Column Sort Order Marker: When you click on a subhead, you change the display of the list to order 
elements by that subhead, either ascending or descending or none. When the order is being 
affected, the box prints a small up or down caret in the subhead to reflect that. This option lets you 
pick a color that may have better contrast than the default, selecting from gray, red, or yellow. 

Clear OrderBy: This clears the current ordering in the box, returning it to default (alphabetical by 
name), and refreshes the list. 

Double Width: This tells GCA that you’d like to display this box at double the normal column width. 

Double-Click Opens Trait Dialog: This is non-standard Windows behavior, so it’s an option you have 
to set for each trait-box. When checked, double-clicking the Gear menu will open the Traits Dialog 
for the type of trait displayed in this box. 

Traits Dialog: Opens the Traits Dialog for the type of trait displayed in this box. 
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CLASSIC VIEW 
CLASSIC VIEW is GCA’s traditional interface style of different tabs for the different trait types 
(advantages, skills, etc.).  

 

In this view, each tab has a list of available library traits on the left side and a list of the character’s 
traits on the right side. As you add traits from the LIBRARY LIST, the CHARACTER LIST fills up. 

At the top of each of these tabs (except ATTRIBUTES) is the categories drop-down list, which allows 
you to change the selection of traits displayed in the library and character lists based on the 
categories available for this type of trait. 

At the far right of the categories drop-down is the filter button. Press that to show or hide the FILTER 
pane.  

When the FILTER pane is displayed, you can type into the filter field to have the LIBRARY LIST display 
only the traits that contain the typed text. 

Between the two lists are the Add and Remove buttons. 

Add: Adds the selected library items to the character. You can also double-click or tap the Enter key. 

Remove: Removes the selected character items from the character. You can also tap the Delete key. 
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At the bottom of the CHARACTER LIST is the BUTTON PANEL. These buttons apply to the currently 
selected items in the CHARACTER LIST. 

Edit…: This opens the Edit Traits dialog for the selected traits. 

Decrement: This decreases the level or score of the selected traits. 

Increment: This increases the level or score of the selected traits. 

Modifiers: This opens the Modifiers dialog for the selected traits. 

The ATTRIBUTES TAB is a bit different than the others since you don’t generally add or remove most 
attributes. This tab instead has a list of the most common attributes on the left, and the full list of all 
character attributes on the right. Many of the character attributes are hidden, because so many are 
used for so many different things behind the scenes; in most cases you’ll never need to know about 
those. 

 

The BUTTON PANELS at the bottom of each of the ATTRIBUTES pane and the ALL ATTRIBUTES pane work 
just like those in described above. 

Between the two attribute panes you have a couple boxes: 

GENERAL INFORMATION: This is the General Information box from UNIFIED VIEW which allows you to 
enter some general information about your character and reference some basic information for 
them based on their attributes. 
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ENCUMBRANCE & MOVE: This is the Encumbrance & Move box from UNIFIED VIEW which displays 
current encumbrance levels and related movement, dodge, and carry values. You can also change 
the current loadout with the Loadout drop-down. 

At the bottom of the center panel is the Create New Attribute button which allows for adding a new 
attribute of your own creation. 

CAPACITY METERS 
The character’s trait lists support displaying capacity meters.  

RIGHT-CLICK MENU 
If you right-click a selected trait, you will get the right-click menu, which duplicates the Traits 
Menu. 

LIBRARY LIST ICONS 
The LIBRARY LIST has icons to the left of each trait name that tell you something about what the trait 
does—if it’s not a typical trait. 

 

Build: When added to the character, this trait will ask for some text input, and/or call up the Edit 
Traits or the Modifiers dialog. 

Wizard: This trait is set up like a wizard, and when you add it to the character it will require you to 
make one or more choices or selections. This icon supersedes the Build icon, so those elements may 
also be required when you see this icon. 

CHARACTER LIST ICONS 
The CHARACTER LIST has several different columns of icons that tell you something about the trait. 
Only the applicable icons appear, and some only appear for certain types of traits. 

LEFT SIDE ICONS 
The icons in ‘column 0’ along the left side of the list show the status of several flags related to the 
trait. Here are the icons that might appear and what flags they represent: 

 

No Flags: None of the flags apply to the trait. 

Leveled: The trait has multiple levels. This isn’t flagged for skills or spells since that is standard for 
them. 
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Prereq: The trait is missing one or more prerequisites. 

Default: The trait is being defaulted from another trait. Only applies to skills or spells. 

Taboo: One or more traits that are taboo for this trait are on the character. 

These flags may be combined in various ways to get the full set of icons shown above. 

RIGHT SIDE ICONS 
There are two columns of icons along the right side of the list, indicating different types of 
information. The first (inner) column might include these icons: 

 

Locked: This trait is locked and can’t be edited or modified. 

Inactive: This trait is currently inactive, so it is not granting bonuses and doesn’t count as a 
prerequisite. 

Linked: This trait is linked to another, most commonly because it is a component of a racial 
template or meta-trait. 

Linked (Broken): The trait to which this one is linked can’t be found. 

GM Sheet: This trait has been flagged for inclusion on the GM Sheet (or any other sheet or plugin 
that wants to use that information). 

Overspent: This skill or spell has had more points invested in it than necessary for the current 
level. 

Existing: This icon only appears on Select dialogs and indicates that the trait is one that the 
character already has. 

The second (outer) column might include these icons: 

 

Parent: This trait is a parent item and is open to having new children added. 

Parent (Closed): This trait is a parent item and has been closed to having new children added. 
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Child Profile – Alternate Abilities: This trait is a child, and the parent is set up as a group of 
alternative abilities. 

Child Profile – Shared Modifiers: This trait is a child, and the parent is set up to share its 
modifiers with its children. 

Component Owner: This trait is a template or meta-trait that has component items.  
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SHEET VIEW 
SHEET VIEW allows you to work with a whole character sheet at once. This offers the ability to work 
directly on a character sheet that you may like to print, but such sheets must be specially written to 
support the interface elements required to be interactive. Likewise, because a sheet’s primary 
purpose is to be printed, there are a lot of features that may simply not be available from the 
character sheet itself, and you may have to switch to another view to do a particular task. 

 

When you are working on a sheet that supports on-sheet editing features, the available fields will 
be highlighted in some fashion, often set in the options for the sheet. In the sample image above, all 
the green areas are active and can be interacted with. 

Depending on the kind of field, you may either be able to edit a value directly after clicking on the 
field, or you may get an edit panel with various edit options. The exact nature of an edit panel is set 
by the sheet being used. 

If you right-click the currently active trait (the one currently showing an edit panel), you will get the 
right-click menu, which duplicates the Traits Menu. 

SHEET VIEW TOOLBAR 

 

This toolbar allows access to commonly needed features within the SHEET VIEW. 
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Here are the buttons on the toolbar from left to right: 

Library Pane: Allows you to open or close the Library Pane along the left side of the View. 

Thumbnails Pane: Allows you to close the navigation pane showing the thumbnails of the pages. 

Print: Prints to a printer. It opens the standard Windows PRINT dialog first, so you can select a 
printer to print to. 

Page Setup: Opens a PAGE SETUP dialog so you can set paper size and margins.  

Note: Many printer drivers do not properly support many paper sizes. If you try selecting a size that 
doesn’t seem to affect the paper size, this may be the problem. The only workaround is to try a 
different driver (or to pick a different paper size). There’s nothing that can be done on GCA’s end, 
since the print engine, Windows, and printer drivers are all black boxes for this purpose. 

View Whole Page: This adjusts the zoom level to fit the entire page into the display area. 

View Page Width: This adjusts the zoom level to fit the width of the page into the display area. 

Zoom Out: Decreases to the next smaller zoom level. 

Zoom In: Increases to the next larger zoom level. 

Favorite: Sets the current sheet profile as the character’s primary character sheet. 

Sheet: You may change the sheet you’re using to view the character. All active sheet profiles will be 
listed in the drop-down list. 

Note: Not all sheets include the extra programming necessary to allow for editing in the Sheet View, 
and even if they do, it may be turned off. If you have a sheet that doesn’t appear to allow editing, 
check Sheet Options to see if you can enable it there. 

LIBRARY PANE 
Along the left side of this View is the Library pane. This is where you can select all the various types 
of traits to add to your character from the character’s library. 
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PARTY VIEW 
PARTY VIEW allows you to work with all loaded characters at once, with customizable cards 
displaying various information. However, it’s also limited in that the cards only display traits that 
are marked to be displayed on the GM Sheet, since this view is an out-growth of that idea. 
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ABOUT 
Shows information about the program. 

 

This dialog provides simple information about GCA, including copyright information for the 
program, and the versions of the primary components. 

When GCA starts up, this dialog is displayed briefly as a splash screen, but will close automatically 
while GCA initializes. 
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ADD TAG 
Allows you to add a tag to a trait. If you try to add a tag that already exists, the existing value should 
appear in the Value field. 

 

The Tag dropdown list at the top allows you to select almost any tag known to GCA. You can also 
type in your own tag name if you want to add a custom tag. 

The Value field allows you to enter the value you want the tag to have. 

The DEFINITION pane at the bottom provides information about known tags. 

DEFINITION PANE 
The DEFINITION pane will provide you with information about known tags when they are selected in 
the Tag dropdown list. 

The information displayed includes the name of the tag, and whether it is Managed, Calculated, or 
Editable. There will also be a brief explanation of what the tag is for. 

If a tag is Managed, that, means that GCA manages that data for you. You can often change the data 
yourself, and it may have an effect, but GCA may change it again in the future. 

If a tag is Calculated, that, means that GCA calculates these values. Changing a calculated value will 
never have a lasting effect, because GCA will recalculate it often, always replacing the value with the 
most recently calculated one. 

If a tag is Editable, that means it is normal data, and you can change it as needed to implement 
changes you want to make. 
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ADVANCED EDIT TRAITS 
This dialog allows you access to all the non-mode tags for a trait. (Mode tags are those that are used 
for attack modes, and for certain 
other special features that are 
commonly used with modes but 
may not always be so.) 

At the bottom of the window is the 
DEFINITION pane, and below that 
various buttons. 

TAG GRID 
This grid provides you a way to 
access and edit every (non-mode) 
tag that describes and controls the 
trait being edited. If you want to edit 
tags that feature in attack modes, 
click the Edit Modes button at the 
bottom left. 

The fields in the grid are shaded to 
indicate the way GCA manages 
them.  

Light blue shading, such as the 
basedon tag at the top, means that 
the value is Managed. 

Light red shading, such as level or 
points, means that the value is 
Calculated. 

White backgrounds are normal 
Editable data. 

See DEFINITION PANE below for more 
info on Managed, Calculated, and 
Editable. 

The currently selected row in the 
grid will be highlighted in gold. You 
can double-click with the mouse to 
open the field editor, or you can 
start typing if you want to enter new 
data by replacing the existing data. 
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DEFINITION PANE 
The DEFINITION pane will provide you with information about each tag when you click on its row in 
the grid above. 

The information displayed includes the name of the tag, and whether it is Managed, Calculated, or 
Editable. There will also be a brief explanation of what the tag is for. 

If a tag is Managed, that, means that GCA manages that data for you. You can often change the data 
yourself, and it may have an effect, but GCA may change it again in the future. 

If a tag is Calculated, that, means that GCA calculates these values. Changing a calculated value will 
never have a lasting effect, because GCA will recalculate it often, always replacing the value with the 
most recently calculated one. 

If a tag is Editable, that means it is normal data, and you can change it as needed to implement 
changes you want to make. 

BUTTONS 
Add Tag: This allows you to add a new tag to the trait. You can add known tags, or your own custom 
tags, if you need to include something GCA doesn’t handle for you. 

Remove Tag: This allows you to remove the currently selected tag. Note that if it’s a calculated tag, it 
will be returned to the trait shortly, and if it’s a managed tag, it may be returned depending on the 
tag.  

Removing a necessary editable tag may completely change how the trait works. For example, 
removing the cost tag will result in an advantage becoming a 0-point item, and lose any ability to 
adjust levels for a leveled trait. 

Save to File…: This allows you to save your custom edited trait to a book file for use in other 
libraries. 

Edit Modes: This calls up the Edit Modes dialog, which works almost identically to this one, but 
supports attack modes or special mode-specific features. 

OK: This closes the dialog, saving your changes to the trait. 

Cancel: This closes the dialog without saving any of your changes. 
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APPEARANCE 
The APPEARANCE Dialog is where you can set the general appearance qualities for your character, 
such as race, height, weight, and age. You can also write a short descriptive blurb.  
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BUILD CAMPAIGN BOOK 
This dialog allows you to load a library, delete traits you don't like, and then save the entire thing as 
a single book file (.GDF file). Optionally, you can save a campaign library (.GDS file) for it as well. 
This should help simplify building campaign specific files for sharing with players. 

 

Start by clicking the Change button to select the library you want to use as your starting point. 
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That will bring up the Manage Your Library dialog so that you can choose the library. Once you do 
that, the library name will appear here, and the available traits will be filled into the lists below. 

FINISHING UP 
When you’re done making your changes on the TRAITS and SETTINGS tabs (see below), click the Save 
as Book button to save to your custom book to disk. You can then click the Create Library using Book 
button to create a library with this book, so it’ll be ready for you in Manage Your Library later. 

If you click the Close button, the window will immediately close and you will lose any changes you 
have not already saved. 

NOTES 
1) If you change libraries, any existing work on your book will be lost, so be sure to start with 

the right library. 
2) GCA loads an alternate copy of the GCA System for this window, so no changes you make to 

the working library here will affect characters or libraries currently loaded in GCA. 
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TRAITS TAB 

 

Remove the traits you don’t want by selecting them in the Library list, and moving them to the 
Deleted Traits list. If you change your mind, you can use the Restore button to undelete the traits 
selected in the Deleted Traits list. 

You can change the type of trait you want to work with, and the category you want to look at, using 
the drop-down lists in the selction area. 

If you want to filter by a more complex formula, you can use the Filter pane here. Unlike the simple 
filter panes in most of GCA where only the name of the trait is matched against what you type, this 
filter uses a search syntax. 

 

In this syntax, you can search for a specific tag with desired value or exclusion, or a combination of 
those. For example, if you enter into the filter field displaycost includes “varies”, then when 
you click Apply only the traits such as _New Advantage or Injury Tolerance, which show 
varies in the listing, will be displayed in the Library list. On the other hand, if you enter 
displaycost excludes “varies” then you’ll see everything where displaycost() doesn’t include 
varies. If you want to see very trait that references brawling in its damage calculation, you could 
enter damage includes "karate" and see the resulting traits. 

After you type in the search phrase, click Apply to use it. Clear will remove it. A filter remains in 
effect even when you change the trait list or category you’re working with, until you press Clear. 

SETTINGS TAB 
You can also include values for various options settings supported by books if you want to change 
those. 
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There are two groups of settings: Campaign and Rules. When saving the book to disk, GCA will only 
save the settings for the groups that you choose to include, but it will include all the settings from 
those groups. 

If you check the Include Campaign Settings checkbox, you’ll be provided a pane allowing you to 
specify the settings as you want them. 

 

If you check the Include Rules Settings checkbox, you’ll be provided a pane allowing you to specify 
those settings as you want them. 
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Note that this Rules pane is the same settings box as appears on the Default Character Options tab 
of the Options dialog. 
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ARMOR LAYERS MANAGER (PROTECTION) 
This dialog allows you to create manage your armor in the layers it’s worn in. This is a specialty 
feature for players in games that track armor penetration layer by layer. 

You must check the box to use 
the rest of the dialog. If you 
don’t, GCA will continue to 
handle all of that itself, 
combining layered protection 
into a single final DR value as 
best it can. 

The MANAGE LAYERS PANE allows 
you to move your worn armor 
up or down to move it toward 
the innermost or outermost 
layer. You can also move traits 
that provide armor, such as 
innate DR or force fields or 
whatever. This allows for full 
customizability to support your 
particular character. 

Using the toolbar buttons, you 
can manually apply whether a 
particular trait should count as a 
layer (for tracking layers that 
count against your DX), and 
whether it’s flexible or not. 
Armor items include that in their 
data, so are not generally 

adjustable that way. 

The icon for each list item displays whether it is flexible or rigid. 
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CAMPAIGN LOG 
The CAMPAIGN LOG is where you can track how your character advances over time, writing notes or 
journal entries and tracking earned experience and money. 

 

You can click on a log entry in the log entries list box and the information for that entry will 
populate in the SELECTED LOG ENTRY pane on the right. 

Add: Click to add a new log entry. You’ll always begin with an entry created by GCA, noting when 
you first created the character. 

Delete: Click to delete the currently selected log entry. Be careful: if you then click OK, you won’t be 
able to retrieve that entry again. If you do delete an entry accidentally, use the Cancel button to 
close and discard your changes. 

OK: Click to close the dialog and commit all your changes to the character. 

Cancel: Click to close the dialog and discard your changes. This means that any deleted entries 
won’t be deleted any more, but also any new entries will be lost. 

Search: Click to open the SEARCH PANE.  
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When the SEARCH PANE is open, you can type the word or phrase to find, and click the Find button to 
find all log entries that contain it. Those entries will be shown in the LOG ENTRIES LIST BOX above, 
where you can click them normally to interact with them on the SELECTED LOG ENTRY PANE. 

When you’re done searching, click the Search button again to close the SEARCH PANE, and to 
repopulate the log entries list box with all the entries. 

POINTS & MONEY EARNED 
This pane shows you the total for all log entries, plus the totals that include what is entered in the 
From Other Sources boxes. 

However, you are encouraged to record any earned points with a log entry and a note, so that you 
don’t later forget why you have those extra points. 

SELECTED LOG ENTRY PANE 
Here you can enter or edit all the information for the log entry. You can give it a caption, which will 
be shown in the entry listings on the left, as well as dates, points earned, money earned, and the 
notes for the entry. 

You should note that the Date field is for the real-world date, while the Campaign Date is for 
whatever method of date-keeping is used in your campaign (it’s a simple non-formatted text entry 
box). 

The Notes field is technically an RTF edit field, so you can paste RTF formatted text into it. Also of 
note: if you tap the Enter key, that will register as clicking OK for the dialog, so use CTRL+ENTER to 
start new paragraphs, or edit the text elsewhere and paste it in. 
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CAMPAIGN SETTINGS 
The CAMPAIGN SETTINGS dialog allows you to specify the initial values for your character, based on 
the campaign being played. 

 

If your campaign doesn’t use the disadvantage and/or quirk limit options, you can uncheck them 
and GCA won’t attempt to alert you that you’re exceeding those limits. 

If you’re playing in a campaign that has an unusual tech level, such as 4+1 or 9^, you can click the 
Advanced button to open the DISPLAY SCORE BUILDER dialog. 

Note that Tech Level at its root is a numeric value and needs to have that numeric value so that a 
higher or lower tech level can be calculated, but you don’t have to show that value if it doesn’t fit 
the campaign’s TL scheme. 
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CHARACTER SHEET OPTIONS 
This dialog allows you to access and change options for all known sheet plugins (character sheets 
and export sheets). You can also create profiles, which are named options settings for sheets that 
allow you to quickly switch between the profiles as if they were different sheets. 

All the options displayed here for each sheet are set by the sheet itself, so they will vary greatly 
from sheet to sheet. 
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CHARACTER TAGS 
This dialog allows you to view and edit the tags assigned to the character itself, as opposed to those 
that make up traits. 

 

As with other such tag-oriented dialogs, the tags are listed on the left of the grid, and their values 
are on the right. Below that is the definition pane. 

At the bottom are the buttons that allow you to add a new tag, or remove the currently selected tag. 

Note that most character data is not stored in tags, so character tags are generally used to store 
custom data. However, sheets and other plugins can use the tags system to access many of the 
features of a character as if they were tags. Data accessed that way will not appear on this dialog. 
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COMBINATION EDITOR 
This dialog allows you to create a combination, as used in GURPS Martial Arts. 

 

The Available Attacks list on the left includes your character’s Targeted Attack techniques, plus a 
couple wizards to allow you to create new ones on the fly. Other than the mix of a couple system 
traits with your character’s applicable traits, this dialog works much like others of this style—add 
things from the left side to the right side. 

Change the name of your combination in the Name field. 

The Level and Points fields are not editable. The Level field will have two or three levels displayed 
depending on the type of combination you are editing. 

You can adjust the points you currently have spent in the combination using the decrement and 
increment buttons next to the Points field. 

Depending on whether you elected to make a 2-attack or a 3-attack combination, the editor will 
display an error message in the Level field if you have too many or too few attacks in the INCLUDED 
ATTACKS list. 

You can adjust the order of the attacks using the move up and move down arrows on the right side. 

If you have special options that apply, such as Trained by a Master, you can check boxes for them in 
the SPECIAL OPTIONS pane. 

The yellow CRITERIA pane will alert you to whether you are allowed 2 or 3 attacks, and how many 
you currently have included. 
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CREDITS 
This dialog displays the credits for GCA, the GURPS line, and related Steve Jackson Games staff. 
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DESCRIPTION/NOTES 
This dialog has two tabs, one for your character’s Description and one for their Notes. 

 

Both tabs are identical, just containing different pieces of freeform text that you can write as you 
please. This is an RTF enabled editor, so you can format your text if you wish. 
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DISPLAY SCORE BUILDER (CAMPAIGN SETTINGS) 
This dialog is available from the Campaign Settings dialog and allows you to specify a TL that isn’t a 
simple number, in case you need that. GCA needs a base number for TL so that it can handle 
characters with TL above or below the campaign default. This dialog allow you to build complex TL 
values while still allowing for the campaign’s base level. 

 

In the image above, the displayed score of 8+1^ is built with the base TL score included. If you were 
to check the Do not include the score box, the score would appear as +1^. 
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EDIT MODES 
This dialog allows you access to all the mode tags for a trait. Mode tags are those that are used for 
attack modes, and for certain other special features 
that are commonly used with modes. 

At the bottom of the window is the DEFINITION pane, 
and below that various buttons. 

TAG GRID 
This grid provides you a way to access and edit every 
mode tag that describes and controls the modes for 
the trait being edited. There will be several columns, 
one for the tags available, and then one each for the 
various modes. If there are not any modes currently 
defined, only the tag name column will be visible, and 
you’ll have to add a mode to start editing. 

At the top of the grid is the Show Calculated Tags 
checkbox. This is off by default, but you can turn it on 
to see all the mode tags that GCA calculates based on 
the other mode data. Note that changing data in the 
calculated tags is a pointless exercise, since GCA 
recalculates all those values. 

The fields in the grid are shaded to indicate the way 
GCA manages them.  

Light blue shading means that the value is Managed. 

Light red shading, such as all of the calculated tags, if 
you turn those on, means that the value is Calculated. 

White backgrounds are normal Editable data. 

See DEFINITION PANE below for more info on Managed, 
Calculated, and Editable. 

The currently selected row in the grid will be 
highlighted in gold. You can double-click with the 
mouse to open the field editor, or you can start typing 
if you want to enter new data by replacing the existing 
data. 

If you have more than one mode column showing, be 
sure you have selected the correct column for the 
mode you want before editing the data. 

DEFINITION PANE 
The DEFINITION PANE will provide you with information about each tag when you click on its row in 
the grid above. 
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The information displayed includes the name of the tag, and whether it is Managed, Calculated, or 
Editable. There will also be a brief explanation of what the tag is for. 

If a tag is Managed, that, means that GCA manages that data for you. You can often change the data 
yourself, and it may have an effect, but GCA may change it again in the future. 

If a tag is Calculated, that, means that GCA calculates these values. Changing a calculated value will 
never have a lasting effect, because GCA will recalculate it often, always replacing the value with the 
most recently calculated one. 

If a tag is Editable, that means it is normal data, and you can change it as needed to implement 
changes you want to make. 

BUTTONS 
Add Mode: This allows you to add a new mode to the trait, which will show a new column in the 
grid. 

Remove Mode: This allows you to remove the currently selected mode. Be sure you have the right 
column with the active gold highlighted field before you try to remove it. 

OK: This closes the dialog, saving your changes to the modes and into the trait. 

Cancel: This closes the dialog without saving any of your changes. 

RIGHT-CLICK MENU 
You must have a field of a mode selected to enable these options. 

Copy: This allows you to copy the currently selected value onto 
the clipboard. 

Paste: This allows you to paste a value into the current field. 

Copy Mode: This allows you to copy onto the clipboard the entire mode that is currently selected. 

Paste Mode: This allows you to paste a copied mode into the current mode, replacing the values of 
the current mode with those from the one on the clipboard. 

Duplicate Mode: This allows you to quickly duplicate the currently selected mode. (This will leave a 
copy of the mode on the clipboard.) 
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EDIT TRAITS 
This dialog allows you to edit or view all the commonly needed features of a trait. If you’ve opened 
multiple traits for editing, they’ll each be available as a separate tab. 

 

At the top of the edit area are the Name, Name Extension, Level, and Points fields. Points is greyed 
out when you can only adjust it by adjusting the traits level. Level and Points will be replaced by 
Quantity, Cost, and Weight when you’re looking at equipment. 

You can click the Save to File button to save the trait, and any changes you’ve made to it, to your 
own book file for use with other characters in the future. 

The CURRENT MODIFIERS APPLIED section will show you the current modifiers. You can adjust 
modifiers directly if they’re leveled or click the inline Delete or Edit buttons for the selected 
modifier to remove or edit it. Click the Modifiers button to launch the Modifiers dialog. 

The User Notes and Description fields are there primarily for your use. Description may be filled 
with text about the trait from the book it came from. 

The Page field contains page references using the page short-codes that GCA recognizes. This allows 
GCA to link those pages to PDFs and launch them for you when you click a page link. You may edit 
this, either to include your own page references or to remove ones that don’t help you. 
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NOTES is general notes about the trait that GCA manages. 

BONUSES GENERATED shows you what bonuses this trait may apply to other traits. You may also see 
CONDITIONAL BONUSES GEN. if the trait also generates conditional bonuses. 

 

The Edit Modes button allows you to launch the Edit Modes dialog, so you can add, remove, or 
modify the attack modes that might be related to this trait. If the trait already has attack modes, 
they’ll be displayed here above this button, while any information about usage counts and 
checkboxes for tracking them will be displayed below this button. 

The Advanced button will launch the Advanced Edit Traits dialog. 

Checking Show all fields will tell GCA to include a lot more panes of information in the editing area, 
allowing you to see more of the building blocks of the trait as well as more informational blocks. 
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You’ll be able to specify familiarities and storage locations (when appropriate to the trait), 
prerequisites (or NEEDS as GCA tracks them) and taboos, and possibly more. You’ll also be able to 
create or edit bonuses using GCA’s gives syntax, or the GIVES BUILDER for the more straight-forward 
bonuses. 
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FIND TRAITS 
This dialog allows you to search for traits in the current library, or in the current character. 

Generally, you would search for traits to add to your character, but if you have a lot of traits on a 
character, and can’t seem to find one, this may help locate where it is. 

 

In this example, the word acute has been entered into the Find… box and Find Now has been 
clicked. All the results that were found have been displayed in the RESULTS list. 

You can click on items and click Add to Character to add them to the active character. 

Find…: Enter the text to search for. 

Inside…: Pick whether you want to look inside the active character or their library. 

Limit To…: Select All Traits or any specific trait list (Advantages, Equipment, etc.). 

Compare To…: Select whether you only want to search through trait names, or if you want GCA to 
look deeper within traits by looking inside their tags. Selecting All Tags may slow the search, but 
will return traits that may include your search term in defaults, descriptions, notes, etc. 

Find Now: Click to perform the search. 

Add to Character: Adds the selected items to your character. 
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FLOATER 
This is a specialty dialog that works much like a toolbar because it floats above the rest of GCA 
when it is displayed. 

 

The FLOATER currently exists just to display Uses information for traits that you click on as you 
work in GCA. This allows you to quickly adjust Uses used or replaced as you are playing. The 
checkboxes for Uses can also be found in the Edit Traits dialog if you prefer to access it there. 

If you have closed the FLOATER but want it to start appearing again, you can turn it back on in the 
View menu. 
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FOLDER LOCATIONS (OPTIONS) 
This dialog allows you to tell GCA what your preferred folders are for the various types of 
documents that GCA may go looking for in your Documents folder. 

 

You are welcome to use the defaults that GCA creates for you in Documents, but if you don’t like 
those, create your own and tell GCA to use them here. 



72 
 

GROUPS 
This dialog allows you to review the Groups that your character currently recognizes. 

 

Groups are initially set by the library being used when the character was created. If you change 
libraries, you can Resynchronize the groups to update the character with the groups from the new 
library. 

Some traits may also opt themselves into a group using the group() tag. Those attributes will not 
be displayed here, because this list is only based on the internal group lists learned from the library. 
A trait that opts itself into a group is still found by GCA when it looks for elements of a group, but it 
does that on the fly, in addition to referencing this list. 
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LOADOUT MANAGER 
This dialog allows you to create loadouts for your character, allowing you to quickly switch 
between different loadouts. Since loadouts are used to apply protection and determine 
encumbrance, you can quickly change what your character is wearing and how protected they are. 

 

At the bottom of the window is the ACTIVE LOADOUT PANE. This shows you the total weight and 
encumbrance for the specified loadout, and the loadout you select there is the one that GCA is using 
to determine encumbrance for the character. 

The rest of the window is devoted to the LOADOUTS PANE.  

LOADOUTS PANE 
The grid lists every item that is not a child of another item. Child items are not included because 
they’re considered to be contained within the parent. Bear this in mind if you have a bunch of 
parent-child relationships. 

Above the grid is a row of buttons, and a display field. The display field shows the name of the 
currently selected loadout (which will also be showing a gold-shaded cell in the grid). You must 
have a loadout selected to use some of the buttons. 
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Add: Click this button to create a new, empty loadout. You’ll get a popup for the name, and then it 
will appear on the grid immediately, ready to be assigned items. Note: Any loadouts that you create, 
but which contain no items when the window is closed, will be removed. 

Copy: Click this button to copy the currently selected loadout to a new loadout. You’ll get a popup 
for the name, and then the new loadout will appear on the grid, with the same items included as the 
copied loadout. 

Delete: Click this button to delete the currently selected loadout. You’ll be asked to confirm, and if 
you do, the loadout will be deleted. 

Rename: Click this button to change the name of the currently selected loadout You’ll get a popup 
for the new name, and the change will be applied if no other loadout with that name already exists. 

LOADOUTS AND UNASSIGNED ITEMS 
By default, GCA treats every loadout as self-contained. This means that any items not specifically 
assigned to a loadout are not a part of it.  

All remaining items, those unassigned to any loadout, are considered to belong to a virtual loadout 
called All unassigned items that you can use if you want. (And many people never create any other 
loadout, which is why it works this way.) This virtual loadout loses some benefits but works well 
for most people. 

With the default behavior, you will need to assign every item to every loadout you might want it in. 
That works well, and makes explicitly clear what items belong where, and when. But it does require 
some attention. 

You can change this default behavior in Default Character Options and/or Current Character 
Options, so that unassigned items are considered to belong to every loadout. This allows you to 
create smaller, more specialized loadouts that only change certain specific things, but allows 
everything else to remain included in the loadout. This may work better for you, but I have found 
that it ends up being a bit confusing at times. 
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MANAGE YOUR LIBRARY 
This dialog allows you to create character libraries for use with your characters. 

Your library is the full set of books available to you (the bottom pane), but each of your character’s 
libraries will be a subset of the total (the middle pane). 

Note that there is no Cancel button on this dialog, so all changes are final! 

You select a library in the LIBRARY PANE on top. The books it contains are shown in the INCLUDED 
BOOKS PANE in the middle. 

You add books to the INCLUDED BOOKS by selecting them in the bottom pane and clicking the Add to 
included books button, or by double clicking them. 

 

LIBRARY PANE 
The LIBRARY PANE shows the full list of libraries that you have created, and which are available for 
use with characters. When you first start using GCA, the only library you’ll have listed here will be 
the default.gds file. 

When you select a library here, the books that it includes will be listed in the INCLUDED BOOKS PANE. 
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You can add books to the library by selecting them in the bottom pane and clicking the Add to 
included books button, or by double clicking them. 

TOOLBAR 
You’ll be able to create, duplicate, rename, and delete libraries here. 

New 

 

Click this button to start a new library. You’ll get a popup entry dialog to enter the name, but you 
can change it later if you like. 

Duplicate Library 

 

Click this button to duplicate the currently selected library. It will appear selected in the library list 
with the same name but with a number appended to it. It will contain all the same files as the 
original. 

Delete Library 

 

Click this button to delete the currently selected library. 

Change Library Name 

 

Click this button to change the name of the selected library, then type in the new name. 

Change Display View 

 

Click this button to change the display view used for the list of libraries. The display views available 
are those typical in Windows: Large Icons, Small Icons, List, and Tiles. The sample image above is 
List view. 

INCLUDED BOOKS PANE 
The INCLUDED BOOKS PANE shows the books that are included in the currently selected library. 

You can add books to the library by selecting them in the bottom pane and clicking the Add to 
included books button, or by double clicking them. 

TOOLBAR 
You’ll be able to delete books from the library or change the order the books are listed (and 
processed) as well. 

Delete Books 

 

Click this button to remove the currently selected books from the library. 
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Shift Books Up 
 

Click this button to move the currently selected books upward in the listing. 

Shift Books Down 
 

Click this button to move the currently selected books downward in the listing. 

Manage Books 

 

This is a toggle button that displays or hides the ALL BOOKS PANE along the bottom of the window. 

Change Display View 
 

Click this button to change the view used for the list of included books. The display views available 
are those typical in Windows: Large Icons, Small Icons, List, and Tiles. The sample image above is 
List view. 

ALL BOOKS PANE 
The ALL BOOKS PANE along the bottom of the window shows all the books that are in your library, 
both the official books that come with GCA, and those that you’ve created yourself. If you don’t see 
this pane, click the Manage Books button in the INCLUDED BOOKS toolbar to show it. 

TOOLBAR 
You’ll be able to change the collection of books you’re seeing, and if you store your personal books 
in different places, change the folder for those to select from different places. 

GURPS Books 

 

This is a toggle button that displays or hides the books that are included with GCA and found in 
GCA’s system library. 

When on, these books will appear first in the list, and all the related books will have blue icons. 

User Books 

 

This is a toggle button that displays or hides the books that are not included with GCA, but which 
you have added or created yourself. These books are usually found in your Documents folder, 
within the GCA5 folder, in the Books subfolder. 

When on, these books will appear in the list after the GURPS books (if those are being displayed) 
and all the related books will have green icons. 
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Change User Books Folder… 
 

Clicking this button will bring up the standard Windows BROWSE FOR FOLDER dialog to allow you to 
select a different folder for the User Books being displayed in the ALL BOOKS PANE book list. 

Add to Included Books 

 

Clicking this button will add the currently selected books to the list of INCLUDED BOOKS for the 
currently selected library. 

Change Display View 
 

Click this button to change the display view used for the list of books. The display views available 
are those typical in Windows: Large Icons, Small Icons, List, and Tiles. The sample image above is 
List view. 

WHY ORDER MATTERS WHEN LOADING BOOKS 
Order is important when processing the books used by GCA. In most cases, books released later 
should have the most current and correct versions of traits that may be duplicated between them, 
so those being loaded later in the processing order will allow the newer data to replace the older 
data.  

When you’re looking at world books, many will redefine traits to fit the world being described, so 
you would also want those to be loaded after the more general books that are not world specific. 

In addition, many newer books may just add or alter a few bits of an existing trait, and often that 
data in the book will be represented by a command that says add this data to that existing item, and 
for that, the existing item needs to have been already loaded. 

WHY YOU SHOULD ONLY LOAD THE BOOKS YOU NEED 
Many books contain changes or updates that make them incompatible with other books; this is 
especially true when one or more of the books you’re loading are world books or variants. 

In addition, the more books you load, the more traits that you may find in the program that have 
nothing to do with what your campaign is about. It may be appealing at first to load every possible 
thing you may ever want to reference, but that greatly increases the odds that you’ll be loading 
traits that don’t work properly together. 
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MESSAGES 
This dialog will show you all the messages that various traits have displayed during this session. 
These messages might be things like a template telling you to spend extra points on Spells, or a 
modifier telling you that some other modifier is also required when you take it. 

 

Each character saves these messages that are generated for it, but only for the current GCA session. 
The messages are not saved with the character and will not be available for review once the 
character is closed. 
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MODIFIERS 
This dialog allows you to add, edit, find, and review modifiers that are currently applied, or that 
may be applied, to the current trait. 

 

Modifiers are enhancements, limitations, and other helpful trait-modifying features that can be 
applied through the Modifiers system in GCA. This ranges a wide gamut, from things like self-
control rolls to changes in how damage for a trait works. A great many things can be done for you 
automatically using modifiers. 

When you first open the MODIFIERS dialog, the Categories drop-down list will show Specified 
categories: this is the combined list of all modifier groups specific to this trait, but it does not 
include all the modifiers that might otherwise be applicable to the trait. 

 

Be sure to click the Categories drop-down list to see the other categories of modifiers that might 
also be applicable, and which may include general types of modifiers that aren’t specific to any one 
trait. Categories listed here that begin with the _ character are generally applicable modifiers and 
are available to most traits of the same type, but they may not actually be valid for use with any 
particular trait. You’ll still need to understand the rules for the modifiers to be sure you’re applying 
them correctly. 

You should also use some care when applying modifiers. For historical reasons, many modifiers 
that should be leveled, such as the Self-control modifiers shown in the example, are provided as 
multiple individual modifiers instead. Be sure that you don’t include multiple levels of these 
modifiers at once, since only one is intended to be applied at a time. 
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NOTES/DESCRIPTION 
See Description/Notes. 
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OPTIONS 
This dialog allows you to set your preferences for how your GCA operates, as well as various 
preferences related to characters. 

 

PROGRAM OPTIONS 
This tab includes panes related to the operation of GCA in general. 

STARTUP 

 

This pane allows you to specify how you’d like new sessions of GCA to begin. 
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CHARACTERS 

 

This pane allows you to specify how you’d like GCA to assign a character’s library when you decide 
to create a new character. 

If you check the box, GCA will always ask you to pick a library for the character. This is convenient if 
you typically use a lot of different libraries, so you’re less likely to start working with the wrong 
one. 

If you leave the box unchecked, GCA will simply assign the default library to the new character. 

CHECK FOR UPDATES 

 

This pane allows you to specify how often you’d like GCA to check for updates when it starts a new 
session. GCA only does this automatically on startup once, and then not again for at least the 
number of days you specify. 

If you specify 0, GCA will not check for updates automatically at all; you’ll have to manually check 
using the Check for Updates option on the Help menu. 
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EXPLAINERS 

 

This pane allows you to turn on or off the various explainer boxes that appear throughout GCA. You 
can turn most explainers off when you see them, and they will then appear checked in this list. If 
you clear a checkbox, that explainer will reappear next to you open the dialog or pane where it is 
found. 

Any explainers that are checked here are hidden and won’t appear where they normally do. 
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WINDOWS & BOXES 
This pane allows for setting 
preferences related to how GCA 
shows you things in dialogs and info 
boxes. It includes explanatory text 
for every option, so we won’t 
duplicate that here, but we’ll 
explain more fully a few of the 
unusual options. 

Allow display of non-relevant 
modifiers in Modifiers window: This 
checkbox tells the Modifiers dialog 
to include access to every known 
modifier, even those that have 
nothing to do with, and may be 
incompatible with, the trait 
currently being edited. This is an 
advanced option that you should 
use with care, because many 
modifiers are not priced correctly 

when applied in unexpected ways. Some modifiers may also attempt to make changes to traits that 
will not work correctly if they’re not of an expected type. 

Allow auto-setting Tablet mode on startup: It can be very difficult to determine if Windows is 
running in tablet mode. Even if this is set, you may still have to set it manually from the View menu. 
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LISTS 
This pane allows for setting a lot of 
preferences related to how GCA 
shows you things in trait lists. It 
includes explanatory text for every 
option, so we won’t duplicate that 
here, but we’ll explain more fully a 
few of the unusual options. 

Format equipment weights, Format 
equipment costs: These settings 
allow you to specify formatting for 
weights or dollar costs of 
equipment items. The exact syntax 
and effect of the formatting codes 
can be tricky, so it’s best if you leave 
it as simple as possible. 

•  If you don’t want thousands 
separators, remove the comma. 
• If you want more decimal 
places displayed, add one or two 
more zeros after the period. (It 
won’t do you much good to have 
more than four decimal places, since 
that’s the maximum allowed in 
internal rounding.) 

Allow traits highlighted with a 
chosen color to remain displayed 
regardless of the category selected: 
This a long prompt, so there’s no 
additional explanation on the 
dialog, but basically it applies to 

character lists in Classic View and Traits Dialogs when you’re using the category drop-down list to 
change what traits are being displayed. In these areas, changing the category will change the 
displayed traits in both the Library and Character lists. By setting this option to some color, you can 
ensure that specifically highlighted character traits continue to be displayed, regardless of what 
category is currently selected. This can be very helpful when you want to add traits to a parent item, 
for example, that isn’t of the same category of traits you’re currently adding. 
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CHILD ITEMS 

 

This pane allows you to force child items to be displayed in an arbitrary order. 

TRAIT MODIFIERS 

 

This pane allows you to change how modifiers are ordered, and therefore how they’re typically 
displayed. 

DUPLICATES 
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This pane allows you to specify that duplicate traits should be refused, which helps avoid issues of 
the same trait being added more than once without specifying why (through the name extension) 
there are duplicates. 

BOOK PROCESSING 

 

This pane is primarily of interest to users who write book files and like to know what’s going on 
when they’re loading that custom data. 

PDF LAUNCHING 

 

This pane allows you to specify a PDF reader and how it should be launched to access the PDFs that 
you have available for following page references. 

Be aware that every PDF reader tends to have its own special commands for how to open PDFs to 
specific pages. We don’t know all those different commands, so if you want to use a particular 
reader, you’ll have to find your own launch arguments. 
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You can also specify how the links look and work when displayed in the Info Pane. 

USER FOLDERS 

 

If you don’t want to keep your GCA user files in the default Documents folder, you can customize 
that by click the Folders button here and making your preferences known in the Folder Locations 
dialog. 

EXPERIMENTAL FEATURES 

 

This pane is for settings that may still have issues, or that we’re not sure about. 

Both options here are likely to remain available in the future but may move to another pane. 

DEFAULT CHARACTER OPTIONS 
This tab includes settings that specify options or behaviors for newly created characters. Changing 
these options will not affect existing characters, but many of the settings here have corresponding 
options on the Current Character Options tab. 

VALUES 

 

Entering the name here will ensure that every newly created character begins with the given 
player’s name. You can change it later, of course, in several different places in the program. 
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CHARACTER SHEETS 

 

The Primary Sheet is the one that will be used by default when you click the Print or Print Preview 
buttons on the SYSTEM toolbar. 

The primary sheet and the alternative sheets that you check in the ALTERNATIVE SHEETS list will be 
available for quick access in the drop-down lists of the Print and Print Preview toolbar buttons. 

Note that sheets are differentiated by profile, so if you create different profiles for the various 
sheets, they’ll be selectable as different sheets, as shown in the example image. 

EXPORT SHEETS 

 

The Primary Sheet is the one that will be selected by default when you click the Export button on the 
SYSTEM toolbar. 

The primary sheet and the alternative sheets that you check in the ALTERNATIVE SHEETS list will be 
available for quick access in the drop-down list of the Export toolbar button. 

Note that sheets are differentiated by profile, so if you create different profiles for the various 
sheets, they’ll be selectable as different sheets. 
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CAMPAIGN 

 

This pane allows you to set the default campaign settings that you expect to use for most characters. 
Be aware that some books may specify different values and those values should supersede these. 

INTERACTIONS 

 

If you want to open Campaign Settings when you create a new character, check that box. 

If you want to default new characters to using user trait ordering, check that box. 

SYMBOLS AND OPTIONAL DISPLAY 

 

This pane is for a couple visual cues that GCA can display, and some additional data that might be of 
interest at times. 
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Show symbols for traits in Character lists: This option, when checked, will have GCA display any 
symbol images that the traits have. Symbol images are those little icons used to mark some traits as 
mental, physical, social, exotic, and/or supernatural (Basic Set: Characters, p. 32).  

GCA allows for an expanded selection of icons if you desire, and Eric Smith has made a large 
collection of them available to everyone. If you want to try them out, you can Check for Updates and 
then click on the Optional Packages tab. You’ll find them there as the Eric’s Symbol Images 
package. Once that’s installed, you’ll want to include GCA5 Symbols.GDF in your character libraries 
to include the image criteria. Please note that there are a lot of images and criteria, so there will be a 
hit to initial loading times for such libraries. 

Flag overspent skills with an icon:  This setting tells GCA that you want to be alerted when more 
points are spent in a skill than are necessary for the current skill level. GCA will alert you to this 
with a little green flag image in the character skill list display. 

LOADOUTS 

 

GCA’s default handling of loadouts may not be quite the way you want it, and these settings are 
meant to allow for a bit more robustness. 

Render ‘inactive’ any items not in the current loadout: Check this option to improve the robustness 
of GCA’s handling of what items are active at any time. If you have magic items or other items that 
grant bonuses, but aren’t actively being used, then a proper set of loadouts with this option checked 
will help keep only the bonuses that should be applied right now actually applied. 

Gray out inactive items: Checking this option will help to visually reinforce that some items aren’t 
currently active. 

Include unassigned items in the current loadout: If you want loadouts to include items that you 
haven’t assigned to any loadout, check this box. Normally, only the items specifically assigned to the 
current loadout are included, so unassigned items would not be. 
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RULES 

 

These settings have explanatory text, so we won’t go into them here as well. 

CURRENT CHARACTER OPTIONS 
This tab includes settings that can be changed for each loaded character.  

Many of the settings here can also be found on the Default Character Options tab but changing those 
won’t affect the settings here unless you use the Copy from Default button, in which case all those 
defaults will be copied into their corresponding settings here. 

In the top pane, there is a drop-down list of all currently loaded characters. You can change which 
character you’re working with to get their settings in the panes below. 

CHARACTER SHEETS 
This works the same as the Character Sheets pane in Default Character Options, but only affects the 
currently selected character. 

EXPORT SHEETS 
This works the same as the Export Sheets pane in Default Character Options, but only affects the 
currently selected character. 
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INTERACTIONS 

 

This allows you to turn on or off user trait ordering for the currently selected character. 

SYMBOLS AND OPTIONAL DISPLAY 
This works the same as the Symbols and Optional Display pane in Default Character Options, but 
only affects the currently selected character. 

LOADOUTS 
This works the same as the Loadouts pane in Default Character Options, but only affects the 
currently selected character. 

RULES 
This works the same as the Rules pane in Default Character Options, but only affects the currently 
selected character. 

TRAIT TAB/BOX NAMES 

 

This pane allows you to set the names displayed for the trait tabs in Classic View or the trait list 
headings in Unified View, as displayed when the currently selected character is displayed. 
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(This should probably be marked as an experimental feature, as it isn’t fully supported in many 
places.) 

TRAIT LIST GROUPING 

 

This pane allows you to specify that you’d like your traits to be grouped in some fashion 
automatically. Normally, you get just an alphabetical listing. You could create parent items and 
cluster traits with the parents you want them grouped under, but in many cases having grouping 
turned on for that trait type will allow for similar functionality that is handled automatically by GCA 
and without the need for parent traits. 

Select the trait type you want to group in the drop-down list, and then select how you’d like to 
group it in the GROUPING pane. Depending on the option you select, more options will appear below. 
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If you want to group by category, select the Group by category option and you’ll see another 
checkbox and an edit field appear. In this default configuration, all the traits will be broken out to be 
displayed in every category in which they appear. If you only want a few categories broken out, and 
all other items displayed together in an ungrouped list, check the Group only traits matching the 
values listed here box and enter the values you want matched in the entry field. 

 

If you want to get more specific, you can choose almost any tag you want (calculated tags are 
strongly discouraged, because they can move around while you work). Check the Group by specified 
tag option and then fill in the options that appear below. 

Enter the tag you want in the Specify the desired tag here field, or drop-down the list and pick one. If 
you pick a tag that GCA knows is calculated, you’ll get a warning message about that. Keep in mind 
that there are a lot of different tags, and most of them won’t provide grouping that’s likely to be 
meaningful. 

The remaining options allow you to adjust the displayed group headings, or to further limit the tag 
values you want to group. 
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PARTY LOG ENTRY 
This dialog allows you to create a new log entry and post it to all loaded characters at once. 

As with regular log entries, fill in the various fields. Caption is the title of the entry, Date is the real-
world date, Campaign Date is whatever date or period the entry covers using in in-world calendar, 
and Points is the number of character points the log entry grants. 

Notes is the meat of the entry. RTF 
is supported if you paste it in from 
an RTF source, such as WordPad or 
Word. 

You must click the Post Entry button 
to post the log entry to the 
campaign logs of all the loaded 
characters. GCA will not post entries 
unless you do that. 

Clicking the New Entry button will 
start a new Party Log entry. Be sure 
that you click Post Entry before you 
click this, or your work on the 
current entry will be lost. 

Close closes the window. 

There is no way to undo the posting 
of any entries that you have posted 
to characters. If you make a mistake 
and click Post Entry, you will have to 
go into each character’s campaign 
log individually to fix it. 
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PDFS (OPTIONS) 
This dialog allows you to tell GCA where your GURPS PDFs are, and what you’ve named them. This 
allows GCA to make the page references in the Info Pane into clickable links that will launch your 
PDFs for more info when you need it. 

You can set your primary location for your GURPS PDFs in the PDF BIN pane at the top. This 
assumes that most of your files will be in that folder or a sub-folder of it and allows us to both 
simplify path 
displays in the 
KNOWN BOOKS & 
PDFS pane below, 
and to change 
references more 
easily if you later 
move your files. 

In the KNOWN BOOKS 
& PDFS pane, you 
can set file names 
and locations 
individually for each 
PDF you own. Ones 
that you don’t have, 
or that GCA can’t 
fine, will be in red, 
while others will be 
in green. 

The listing is 
alphabetical by book 
name, and most 
books start with 
GURPS, so be aware 
that the ones that 
don’t may feel out of 
place. 

In the sample image, 
you can see that 
most of the book 
panels in green use 
the shortened pathnames. However, you can also see that my Dungeon Fantasy: Adventurers 
book at the top is currently still in my Downloads folder. 

In each book panel, you can click the … button to browse for the location of the PDF. If you click the 
blue URL link at the bottom of the panel, it will take you to that page on the Steve Jackson Games 
web site. 
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You can also enter the Offset for page numbers—the offset is the amount to add or subtract from 
the page reference to get the page to appear properly in the PDF reader when launched. Offsets are 
often needed when cover images or front matter causes the internal page numbers in the PDF 
reader to not match the book’s page numbers. 

If you have a special case where a book is split into two parts, such as with the GURPS Basic Set, you 
can click the downarrow button to display additional parts of the panel, allowing you to set the 
name, path, and offset information for the second book, as well as the last page number for the first 
book, so GCA knows when it should instead launch the second book for a given page reference. 
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PLUGIN MANAGER 
This dialog allows you to see what plugins are available to you within GCA, and to deactivate those 
you don’t want to use. 

 

Sheet plugins, which is all character sheets, whether print sheets or export sheets, are the green 
boxes. 

Control plugins, which are used in the UNIFIED VIEW, are blue boxes. 

Plugins that are disabled are in gray boxes. 

You can filter the displayed plugins using the drop-down list at the top of the window. Note that 
there are no “Other” plugins yet, so it is normal for that display to show nothing. 
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You can disable a plugin by clicking its Disable this plugin button. You can enable a plugin by clicking 
its Enable this plugin button. 
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PORTRAIT 
This dialog allows you to select a portrait image to use for your character. 

 

Portrait images can be in a variety of image formats, such as BMP, GIF, JPG, PNG, or TIF, but be 
aware that some images labeled as one of those types may still be a variant that the image library 
can’t understand, so it may not be able to be loaded. 

Load: Allows you to load an image using the standard Windows FILE OPEN dialog to browse your 
computer and select an image. 

None: Allows you to clear the image, so that the character no longer has a portrait. 

You can also load a portrait image by using drag-and-drop, dropping acceptable images onto the 
Portrait dialog window, or onto most parts of the Main Window. 
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PRINT PREVIEW 
This provides a preview of what your printed character sheet will look like. You can choose to try 
different sheets to view the effects and may export to PDF if you’d like. 

 

The main preview area takes up most of the window. You can scroll through the pages or use the 
pane on the left to jump quick to specific pages. 

Here are the toolbar buttons: 

Print: Prints to a printer. It opens the standard Windows PRINT dialog first, so you can select a 
printer to print to. 

PDF: Saves the print sheet directly to a PDF file. You’ll get a Windows SAVE dialog to choose the 
name and location of the saved file. 

Page Setup: Opens a PAGE SETUP dialog so you can set paper size and margins.  

Note: Many printer drivers do not properly support many paper sizes. If you try selecting a size that 
doesn’t seem to affect the paper size, this may be the problem. The only workaround is to try a 
different driver (or to pick a different paper size). There’s nothing that can be done on GCA’s end, 
since the print engine, Windows, and printer drivers are all black boxes for this purpose. 
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View Whole Page: This adjusts the zoom level to fit the entire page into the display area. 

View Page Width: This adjusts the zoom level to fit the width of the page into the display area. 

Zoom Out: Decreases to the next smaller zoom level. 

Zoom In: Increases to the next larger zoom level. 

Sheet: You may change the sheet you’re using to view the character. All active sheet profiles will be 
listed in the drop-down list. 

Exit: Closes the window. 
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PROTECTION 
This dialog allows you to choose which items in your loadout are actively providing protection to 
your character, select the traits to display on sheets for Parry and Block, select a body type and 
protection image, and select a hit location table. 

 

Note that some features of this dialog are not available when you are assigning protection for the 
virtual All unassigned items loadout. 

The left side of the window contains different tabs for different types of protection and body 
information. 

Just above those tabs, there are two fields that tell you what the current loadout is, and which 
loadout you’re currently working with. That second field is a drop-down list of all the loadouts 
you’ve created for the character in the Loadout Manager. 

PROTECTION IMAGE 
The right side of the window is the PROTECTION IMAGE PANE, which shows you the protection values 
for the typical locations gathered from all the currently active items. 

If you click on a location box, it will highlight the armor items in the armor list (or lists, if the LAYERS 
PANE is open) that are currently providing protection to that location. 
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You can drag the location boxes around to position them to your liking. If you use a different image, 
you’ll have to do that to put them in logical places. 

The inset image shows the DB values that apply in the different shield arcs from active shields. 

USER MANAGED LAYERS 
If you have turned on the box for managing layers yourself, the PROTECTION dialog will have an 
additional pane showing the layering order, and the locations will have changed how they display 
the values they contain, with each layer showing its own value along with a key letter linking it to 
the protection item in the LAYERS PANE. 

 

In this sample image, the LAYERS PANE is placed under the PROTECTION IMAGE, but you can also have it 
to the right of it by clicking the Vertical button. 

LAYERS PANE 
The list here shows each item currently providing protection to the character, in the order you have 
assigned for layering. The flexibility icon along the left side displays whether the protection is 
considered flexible or rigid. The second row for each item is split between the key letter on the left, 
then the protection value, and finally the locations covered aligned to the right edge. 

Items without the flexibility icon are not considered layers for purposes of DX penalty calculation. 
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Vertical: This button appears when the PROTECTION IMAGE and LAYERS PANE are in vertical mode (the 
latter below the former). If you click it, the LAYERS PANE will shift to the right side of the dialog, and 
button will be renamed Horizontal. 

Horizontal: This button appears when the PROTECTION IMAGE and LAYERS PANE are in horizontal mode 
(the latter to the right of the former). If you click it, the LAYERS PANE will shift to appear underneath 
the protection image, and button will be renamed Vertical. 

Value Sep: This button will be removed in the future. 
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ARMOR & SHIELDS TAB 

 

The APPLY ARMOR PANE provides a list of all available armor items that can be checked to apply 
protection to the character. Clicking on an item in this list will highlight the locations that it covers 
on the PROTECTION IMAGE. Only checked items are used to provide protection. 

Below the armor list are some buttons: 

Layers: This button will open the Armor Layers Manager to allow you to specify the order that your 
armor is layered in, for those playing in detailed campaigns where that is important. 

Check All: This will check all the armor items, applying protection from them all. 

Clear All: This will uncheck all the armor items, removing all applied protection. 

The SET SHIELDS pane allows you to set the protection arc covered by the shields you have selected 
in the APPLY ARMOR pane. You can select None for no protection, Left Arm or Right Arm for the arm 
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wielding the shield and therefore the arc of protection that offers, or Back for a shield carried on the 
back that only protects from the rear. 

At the bottom of the tab pane is a checkbox that, in conjunction with not actually applying any 
armor in the loadout, will allow you to manually enter protection values in the various locations, 
rather than having GCA calculate them. If you don’t uncheck this box, and don’t uncheck all armor in 
the list, GCA will always auto-calculate armor as best it can, based on selected armor and protection 
traits. 
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OTHER TAB 

 

This tab includes the FROM OTHER SOURCES PANE, which tells you what your total overall DR and DB 
bonuses are (not including shields); and includes a list of all the traits providing the values that go 
into those totals. 

Below the list, there are some fields where you can enter notes about DR or DB if you need it. 

The ACTIVE DEFENSES PANE allows you to select the Parry and Block scores and traits that are printed 
on some character sheets. 
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BODY & LOCATIONS TAB 

 

This tab allows you to select a body type, which determines all the locations that are available to 
you, and that can be protected by armor. 

There is a default list of body types that are available from the GURPS Basic Set 4th Ed.--
Characters.gdf book file, and there are additional types available in the GURPS Template 
Toolkit 2--Races.gdf book file. 

If a PROTECTION IMAGE has been defined for the body type, you would be able to select it from the 
Image drop-down list. 

Most of the space is devoted to a grid that contains the information for the locations defined in the 
body. 
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You can expand and collapse the grid to see the various locations, and you can have the location 
display boxes appear or disappear from the Protection Image by toggling the Display values. 

If you’re making changes for a custom body, you can set base DR, DB, or HP values for each location. 

Note that changes you make here only apply to this character, and only to this loadout. If you want 
to be able to apply the changes to other characters, you’ll need to save the body to a custom book 
and load that book in that character’s library. 

Reset: This button will reset all the base values to those from the body defined in the character’s 
library. 

Copy From…: This button will allow you to copy a body, and any custom data you entered, from 
another loadout on the character. Clicking will call up a dialog listing the other loadouts, so that you 
can select one. 

Save Body…: This button will allow you to save a copy of this body, as you’ve changed it, to a custom 
book file. You can then use the custom body for other characters by ensuring that you load your 
custom book in their library. 
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HIT TABLE TAB 
This tab allows you to select a hit location table. 

 

For reference, the first entry on the table is the body type currently defined for the loadout. 

The hit location table is often named the same as a particular body type, but not every body type 
has its own hit location table, since most hit location tables allow for targeting far fewer locations 
than most bodies have. 

This tab also shows the defined notes for various results on the table. 

Note: GCA does not currently save any changes you make here. Even though it will allow you to edit 
the table data, changes will not be remembered when you close the dialog. 
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RANDOM CHARACTER 
This dialog allows you to create up to 20 randomly generated characters, all based on the template 
that you pick from the library that you choose to start from. 

 

Be sure to use the Change… button to switch to the correct library, and then select the template 
from the list below to use as the basis of the random characters. 

Change the number of characters to generate if you want more than one. 

If you got to this window from the Apply a Randomized Template… option on the Tools menu, you 
will not see the Number of characters to generate line, since the random template you’re applying 
will be applied only to the currently active character. 

Once you click OK, GCA will begin generating. Newly generated characters are added to the main 
window as they are completed. 
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RECYCLE BIN 
This dialog allows you to see what traits have been deleted from the character this session and 
restore them if desired. 

 

There isn’t a lot to this dialog. Select the trait you wish to restore and click the Restore button to do 
so.  
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RESYNCHRONIZE 
This dialog allows you to resynchronize the data contained within the character with the data from 
the character’s current library. 

GCA characters are built to contain all the information that they need to continue working correctly, 
even when they’re loaded with the wrong library, or with no library at all. This allows them to be 
shared with people who 
may not have the same 
books available, or who 
don’t have the same 
customized data that 
the character was made 
with. It also allows you 
to load and print 
characters regardless of 
what data you have 
available to work with. 

Because of the self-
contained nature of the 
characters, changes 
made to library books 
do not automatically 
affect characters made 
with those books. To 
have those changes 
affect the character, the 
character needs to be 
resynchronized. 
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SAVE BODY TYPE (PROTECTION) 
This dialog allows you to save the Body data in a custom book, so that it can be loaded and used 
with other characters in the future. 

 

Be sure to give your body type a unique name. 

You can click the Browse button to find the specific book you want to write your custom body type 
into. 
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SELECT 
This dialog is used to provide you with a set of traits to choose from and will specify the criteria you 
need to satisfy while making the selections, such as some number of choices or some number of 
points. 

 

As with trait selection in GCA, the list of items to choose from is on the left side, and the list of items 
that you’ve chosen so far is on the right side. 

There are two info bars below the lists that show the current selection requirements. Not all 
sections require both a count and a cost, but many do. As you add or remove your chosen 
selections, the info bars will update. 

The Random button allows you to have GCA randomly make selections that satisfy the 
requirements. If you click the drop-down element on the button, you can also choose the Randomize 
remaining template selections option, which will randomize the selections in this Select dialog, and 
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then also randomly make selections for all remaining SELECT dialogs (and make choices from any 
choice dialogs that appear). 

Generally, you can’t click the OK button until you have made selections that satisfy the 
requirements. However, you can check the Override requirements box to enable the OK button 
anyway. 
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SELECT EXPORT SHEET 
Pick the export sheet you want to use to export the character. 

 

Once you’ve picked the sheet you want in the AVAILABLE EXPORT SHEETS pane, click OK to begin 
exporting or Cancel to exit without doing so. 

Some export sheets will pop up some options for you to set once you begin the export. However, for 
general options related to export sheets, you’ll set those for each sheet in the Character Sheet 
Options dialog. 
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SYSTEM COLORS 
This dialog allows you to change the colors used in many user interface elements throughout GCA. 

Select the type of target object in the list on the left and adjust the various settings for that on the 
right. Library items refer to lists and forms that include and display elements from a library, while 
the Character items refer to lists and forms showing data from the character. In both cases, most of 
the color settings apply to trait displays. 

The toolbar buttons on the left side are: 

Set to Defaults: This will set all colors to GCA’s default (non-dark) color values. 

Set to Darks: This will set all colors to GCA’s built-in dark color values. 

Import…: This allows you 
to import colors from a 
preferences file, if you 
have one that includes 
saved color profiles. 

Export…: This allows you 
to export the current 
color profile to a 
preferences file, so you 
can share it or keep it for 
another time. You must 
fill in the Name field so 
that the profile can be 
referenced in the file. 

The toolbar buttons on 
the right side are: 

Categorized and 
Alphabetical: These 
toggle between the 
Categorized and Alphabetical states, which specifies whether the property grid below displays the 
settings by category (as in the example image) or as a single alphabetical list. 

Property Pages: Not used, so this will stay disabled. 

Unfortunately, this toolbar is built into the properties grid, so we can’t change the size of the 
buttons. 
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TEMPLATE OPTIONS 
This dialog will appear when you select Save as Template from the File menu, and it allows you to 
specify several options related to saving a character as a racial template.  

 

As you can see from our image, we selected to save a template based on Dai Blackthorn, so changing 
the Template Name to something else would probably be a wise idea. The Category field affects 
what category the template will appear within for library lists. 

The elements in the FUNCTION group affect how a racial template will function within GCA. Select the 
options that reflect how you like your racial templates to operate. Most of the racial templates from 
earlier GURPS 4th Edition books have all three of these boxes checked, while later books often do 
not have the Component traits can’t be modified or the Component traits are hidden boxes checked. 

The EXTRAS group allows you to specify that the template uses the specified body type and hit 
location table. If you don’t want them specified, be sure the appropriate boxes are unchecked. 
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TRAITS DIALOGS 
There is a trait dialog available for each type of trait. These dialogs can be opened from certain 
buttons or menus on boxes in Unified View or Sheet View. 

Each trait dialog works the same as the corresponding trait tab in Classic View. In fact, the trait 
dialog is just the contents of the trait tab in a dialog instead of on a tab. 

See Classic View for more information. 
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TRANSFORM MANAGER 
This dialog allows you to create transforms for your character, allowing you to quickly switch 
between different variations.  

Transforms can be a bit difficult to understand at first, but if you think of them as loadouts, but for 
traits instead of gear, then that may help. Basically, having different transforms allows you to swap 
out certain traits for other traits, just by changing which transform is active at any time. 

Always bear in mind that all traits within the non-active transforms are deactivated, which is a lot 
like not existing, because they don’t grant bonuses and they aren’t considered when checking for 
prerequisites; see Transforms Versus Loadouts below for details. 

 

At the bottom of the window is the ACTIVE TRANSFORM pane. This shows you the total cost for all 
items contained in the specified transform, and the transform that you select there is the one that 
GCA is using to determine which traits to enable or disable. 

The rest of the window is devoted to the TRANSFORMS pane.  
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TRANSFORMS PANE 
The grid lists every item that is not a child of another item. Child items are not included, because 
they’re considered to be contained within the parent. Bear this in mind if you have a bunch of 
parent-child relationships. 

Above the grid is a row of buttons, and a display field. The display field shows the name of the 
currently selected transform (which will also be showing a gold-shaded cell in the grid). You must 
have a loadout selected to use some of the buttons. 

Add: Click this button to create a new, empty transform. You’ll get a popup for the name, and then it 
will appear on the grid immediately, ready to be assigned items. Note: Any transforms that you 
create, but which contain no items when the window is closed, will be removed. 

Copy: Click this button to copy the currently selected transform to a new transform. You’ll get a 
popup for the name, and then the new transform will appear on the grid, with the same items 
included as the copied transform. 

Delete: Click this button to delete the currently selected transform. You’ll be asked to confirm, and if 
you do, the transform will be deleted. 

Rename: Click this button to change the name of the currently selected transform. You’ll get a 
popup for the new name, and the change will be applied if no other transform with that name 
already exists. 

TRANSFORMS VERSUS LOADOUTS 
They are similar in many ways, but some of the default behaviors are different. While you can 
change how some of the default behaviors work for loadouts, you can’t do the same with 
transforms. 

The most important thing to understand about transforms is that any trait in a transform that is not 
currently active is deactivated. That means if you have Magery in a transform, and that is not the 
active transform, then your character effectively has no Magery! 

This is very different default behavior to how loadouts work, so it’s important to keep in mind. 

TRANSFORMS AND UNASSIGNED ITEMS 
By default, GCA treats every transform as only part of the whole. This means that any traits not 
specifically assigned to a transform are a part of every variation of the character. 

This default behavior is the inverse of the default behavior for loadouts, but it makes a great deal of 
sense this way, because it’s easy to think of a character having this or that specific template, but 
everything else outside of the template still applies to the character. Transforms are like those 
templates, but you can easily create them yourself for each character that needs them. 

GCA will show you a list for All unassigned items in Transform dropdown lists, and that is a 
valid transform that you can use if you want. Using it means that your character currently has none 
of the traits that are included in any of the other transforms. 
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UNIFIED VIEW LAYOUT (UNIFIED VIEW) 
This dialog allows you to adjust which boxes you see on the Unified View, and the general layout of 
the boxes. 

 

The DISPLAY ORDER pane on the left allows you to control the order of the boxes. While you have a 
box selected there, you can also control whether the box is displayed or not by checking or 
unchecking the Show this box checkbox in the CONTROL pane to the right. 

You can change the order of the boxes using the up and down arrows along the right edge of the 
pane, or you can drag a box to a new position in the list. 

Clicking the Reset button will restore the display order to the default. 

CONTROL PANE 
This pane just allows you to access the Show this box checkbox when you have a box selected in the 
DISPLAY ORDER pane. 

(The boxes on the Unified View are all plugin controls, so you may also be able to disable them in 
the Plugin Manager.) 
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GENERAL SETTINGS PANE 
The GENERAL SETTINGS pane allows you to change the general sizing of the boxes, and the space that 
appears between them (the gutter). Selecting a wider gutter makes it easier to grab an empty place 
on the UNIFIED VIEW panel to drag the panel around. Changing the column widths helps to size most 
boxes to your preferred width. 

Clicking the Reset button will restore the widths and gutters to the default values. 

(Note that changing the border widths here also affects the border widths around similar types of 
trait lists in many other places in GCA.) 
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WORKING 
This window pops up when GCA is working on an extended process, to let you know what’s going 
on during the process. It’s not interactive, but messages should get posted to the info pane on the 
right side as the working process progresses. 
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END MATTER 
CAPACITY METERS 

The character lists in Unified View, Classic View, and the Traits Dialogs can all show capacity meters 
for parent items. Whether a character sheet shows a capacity meter is up to the author of the sheet, 
but many sheets include them. 

A capacity meter allows you to see how close to full, or overfull, a container item might be. 

There are currently three types of capacity meters: weight, count, and child. Weight capacity is the 
total weight of all children the item can hold and applies only to equipment (only equipment items 
have weight). Count capacity is the total count of all children the item can contain and applies only 
to equipment (only equipment items have a count). Child capacity is the number of child items the 
trait can have and applies to all advantage-type traits (which are cultural familiarities, languages, 
advantages, perks, disadvantages, quirks, features, and templates). 

 

In this image, you can see that the Backpack, Small has a green line displayed underneath it, and 
that a portion of the line is filled with a darker green color. That is your capacity meter, showing 
how much of the item’s given weight capacity is currently used. If the line is blue, then you’re seeing 
the capacity meter based on count or child capacity. If an item has both a count and a weight 
capacity, GCA will display whichever is closer to full. 

When an item has exceeded any given capacity, the capacity meter will be solid red. 
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LIBRARY PANE 
The LIBRARY pane can be found in Unified View and Sheet View. This is where you can select all the 
various types of traits to add to your character from the character’s library. 

GEAR MENU 
In the shaded header space at the top of the pane, you will see a gear icon next to the label 
displaying the currently loaded library. Clicking the gear icon will open the Gear menu. 

 

Reload Library: This option will have GCA reload the library 
from disk. If you are saving custom data to your own book 
included in the library, you’ll want to do this to ensure that 
GCA loads that data. GCA does not monitor the books folders 
for changes, so you must request that reload manually. 

Show/Hide Filter Pane: This option shows or hides the filter 
pane. It is shown in the example image.  

TRAIT TYPES DROPDOWN 
This allows you to change the type of traits currently being 
displayed in the LIBRARY LIST. 

CATEGORIES DROPDOWN 
This allows you to limit the types of traits being shown to only 
those that are included in the specified category. 

FILTER PANE 
This allows you to further limit what traits are being displayed 
in the LIBRARY LIST to only those traits that include the text 
snippet you’ve typed here. This, along with the type-to-search 
feature of the list itself, allows you to quickly find and select 
what you’re looking for. 

LIBRARY LIST 
This is the list of all the traits that currently satisfy your 
requirements as set by the TRAIT TYPES DROPDOWN, CATEGORIES 
DROPDOWN, and the FILTER PANE. 

Within the list, you can use type-to-search as well. 
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TYPE-TO-SEARCH 
Within many library and character trait lists, you can use type-to-search, which will move the 
current selection to the first trait that matches all the letters you’ve typed so far. If you type 
additional characters such that nothing matches any more, the type-to-search buffer will then reset 
and start looking for the new buffer text. You can see what is currently in the type-to-search buffer 
on the right side of the Points Bar. 

 

In this image, the user has typed body into the type-to-search buffer, and that is showing in the 
Points Bar. 
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GCA5 PACKAGE MANAGER 
This window is what you see when you choose Check for Updates from the Help menu, or 
periodically when GCA starts up, depending on your Check for Updates setting in Options. 

 

Note that GCA shuts down when it runs the external program that handles the package manager. 
This is so that any packages you might install or update can be installed smoothly without running 
into conflicts with “in use” files. 

Program updates from Steve Jackson Games don’t currently support access through the GCA5 
PACKAGE MANAGER, so when a program update is available, you’ll be informed of it on the Updates 
tab, but you’ll have to download and run the installer for that update yourself. 

From this dialog, you can see what updates are currently available for GCA, if any, and what 
optional packages are available for installation. Optional packages might be additional content, such 
as packages of images or books, or they might be plugins, such as new character sheets or 
exporters. Updates are available for you on the Updates tab, and optional packages on the Optional 
Packages tab. 
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Each available package will tell you if it is installed or not. 

If you want to install a new package, check the This package is not installed checkbox. The Not 
installed text will change to Will be installed. 

If you want to uninstall a package, check the This package is installed checkbox. The Already installed 
text will change to Installed; will be removed. 

If you have changed the status of any packages, either to add or remove a package, then when you 
click the OK button, the Package Manager will make the changes and then refresh the display to 
show you the new status. If you have no changes pending, the OK button will close the window, as 
the Close button does, and return to GCA. 
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